
 Voyetra On-Line Manuals
Click on an application to scroll through a complete on line manual for that program. To print
out a manual click on the application, then press the Print button.

    AudioStation - Component Audio Rack 

    Videostation - Video for Windows Player 

     Imagestation - Image Viewer & Presentation 

 Windows Digital Audio Transport 

    MIDI Orchestrator - MIDI Mixer/Recorder 

    Audio Calendar - Calendar/Scheduler 

    SayIt! - OLE Sound Annotation Application 

    JukeBox 

    Midi Screen Saver 

    Sound Events - Add Sound Effects to Windows 

    Sound Script - Animation and Presentation Player 

    Voice Net - Voice Mail for Novell Networks 

    Level Control - Master Volume Control 

    SoundCheck - Sound System Diagnostics 



Midi Screen Saver
Add music to the Windows screen saver. Play a single MIDI song file, or one of your 
AudioStation MIDI file playlists.

Adding Audio to Screen Savers
The Voyetra Audio Screen Saver is not a separate application nor does it have its own icon. 
Instead, you just add a few extra steps to the procedure you'd normally use to set up the 
Windows 3.1 screen saver. Because it works in this way, the Voyetra Audio Screen Saver is 
compatible with any screen saver that you can configure from the Windows Control Panel, 
such as those in the Microsoft Entertainment Pack. Refer to your Windows documentation if 
you need details on configuring screen savers.

To configure the Audio Screen Saver:

1. Open the Windows Control Panel. 

2. From the Control Panel window, double-click on the Desktop icon. 

3. In the Screen Saver area, open the Name list box and select Voyetra Audio.

4. Click on the Setup button. The Voyetra Audio Screen Saver Configuration dialog box will 
appear.

5. Choose a screen saver from the drop-down list.

If you wish to customize the screen saver parameters, click the Setup button and choose the
color, size, speed, etc. as you ordinarily would.

6. Click on the Browse button.

7. In the Open file dialog box, choose the desired file type: MIDI File or Voyetra MIDI File 
Playlist.

8. Navigate to the drive and directory where your MIDI files and/or Playlists are located, 
double click on a file or playlist and click OK. 

9. If you wish, adjust the delay or any other parameters in the normal fashion.

10. Click on the Test button. The screen saver's graphics should now be accompanied by a 
MIDI song file.

If you selected a playlist, the Audio Screen saver will choose a song in the list at random and
play the list, starting with that song. The starting song will vary each time the screen saver 
is activated. For information on creating and saving a MIDI file playlist, refer to the 
AudioStation chapter.



     Level Control - Master Volume Control
Sometimes all you want is a quick way to adjust volume or balance. This little utility takes 
almost no screen space, does the job with a minimum of fuss and works with all your 
Windows sound applications.

Setting Up the Level Controller

The Level Controller (Lvl) is easiest to use if you place it in your Startup group, so it's 
automatically loaded and always ready on your Windows desktop. (The installation program 
may have done this for you already.) If Lvl doesn't start automatically when you load 
Windows, you'll need to start it as you would any Windows application before you can use it.

You might also want to launch Lvl as a minimized application. When run this way, it appears 
as an icon on your Windows desktop until you press a hot key combination    a short 
sequence of keystrokes    to activate it. The default hot key combination is [Ctrl]-L. You can 
change this combination any time you wish.

Controls and Displays
Balance: Drag this slider left or right to adjust the balance between left and right channels. 
(This feature works only on systems that support stereo.)

Volume Slider: Drag this slider    up or down to adjust the overall output volume level.

Mute: Temporarily turns all sound off.

System Menu
Level control has a standard Windows System Menu, with entries common to most Windows 
applications. There are also three items unique to Level Control:

About Lvl...: Displays the program's revision number and creation date.

Hot Key...: Sets the hot key combination that activates Level Control.

Always on Top: Keeps the Level Control window or icon on top of any other applications 
that are running. 

Operation
To start Level Control as an icon:

1. In the Windows Program Manager, Select the Level Control Icon.

2. From the Program Manager's File menu, select Properties...

3. Click the Run Minimized Check box. An X will appear in the box.

4. Click OK. Each time you start Level Control, it will start as an icon on your Windows 
desktop.



To operate Level Control:

1. Run Level Control, if necessary.

2. If Level control is minimized (i.e., appears as an icon), double-click on its icon or type its 
hot key combination.    (Default is [Ctrl]-L)

3. To set the playback level, drag the volume slider up or down.

4. To adjust the left/right balance, drag the balance slider from side to side.

5. To temporarily silence all sound, click the Mute button. Click the Mute button again to 
restore sound output.

6. When you've finished making your adjustments, you can:

· Leave Level Control on your desktop.

· Click once on the Minimize button to re-minimize Lvl to an icon.

· Double-click the System menu button to close Lvl. If you want to use Lvl again, you must 
restart it.

You might want to change the Hot Key combination that activates Lvl, particularly if another 
application uses the same combination.

To change the Hot Key:

1. From the System Menu, select Hot Key. A dialog box will appear.

2. Use the check boxes to turn Alt or Shift on or off as desired. (The Hot Key combination 
always includes the Control key).

3. To change the letter, drag your cursor across the character in the Key box to select it. 
Type a single letter or numeral of your choice. You can not use punctuation or other special 
characters.

4. Click OK.



 Videostation - Video for Windows Player
VideoStation's intuitive interface makes it easy and fun to play Video files on your PC.

Introduction
VideoStation offers an easy way to select and play Video files in the AVI (Audio/Video 
Interleaved) format used by Microsoft Video for Windows.

What you need to use VideoStation

To play .AVI files with VideoStation, you'll need:

An IBM PC or compatible, with a 386SX or better processor.

At least 2 Megabytes of Random Access Memory (RAM).

A VGA monitor and adapter.

A hard disk drive with a minimum capacity of 30 Megabytes (80 or more megabytes 
recommended).

A soundcard with digital audio capability (for the audio portion of .AVI files).

Microsoft Video for Windows (for the video portion of your .AVI files). A run-time version is
included with VideoStation.

A CD-ROM drive is highly recommended. The drive should have an access time of 1 
second or less, and a data transfer rate of 150 kilobytes per second or faster.

NOTE: An MPC, or Multimedia Personal Computer (as defined by the Multimedia PC 
Marketing Council, Inc.) includes all the hardware necessary to run VideoStation.

To edit .AVI files or to create new ones, you will need to obtain the full version of Video for 
Windows from your software dealer and, depending on your requirements, you may need 
additional hardware.

Screen Displays and Controls
Main Screen

VideoStation's screen resembles a combination television and videocassette recorder. 
Various displays keep you informed as each selection in your playlist is shown.

Displays

File Info Window: A summary of the current file's characteristics: Filename, DOS path, 
Video format and the sample rate and bit length of the file's audio.

Video: Shows which file in the playlist (by number) is currently playing.

Play/Pause: Indicates when VideoStation is playing or paused.

Timer: Displays elapsed time, measured from the beginning of the current video file, in 



minutes:seconds.

Playback Mode: Indicates which of the four playback modes (Playlist, Shuffle, Loop or 
Single) is currently selected.

Controls

On/Off (I/O) Button: Closes VideoStation.

Help button: Activates VideoStation's online help.

Playlist Button: Opens the Playlist window.

Volume Slider: Controls playback level of the sound portion of the file.

Playback Mode    button: Toggles through four Playback modes; Playlist, Shuffle, Loop and 
Single. The current mode is displayed at the far right of the Timer.

Transport Controls: VideoStation uses transport controls common to many Voyetra 
applications. Their operation is explained in the included "Common Controls" file.

Playback Options

Window/Full Screen: Allows you to display videos in the window or to use the entire 
screen.

Zoom by 2: Shows the image doubled in size. Only the middle portion of the video is shown
in this mode, the edges are cropped.

Skip Video if Behind: When active, permits VideoStation to skip video frames if the 
computer system cannot keep up with the data rate requirements of the .AVI file. This option
helps to preserve sound quality, but at the expense of video.

The Playlist Window

The first step in using VideoStation is to construct a playlist of the files you'd like to see. 
Click on the Playlist button at the lower left of your screen to open the Playlist Window.

In the Playlist Window you can create, edit and save as many playlists as you wish. 

Files box

The Files box at the left of the Playlist Window has two windows for browsing through files 
and directories. It operates just like any Windows "File open" dialog box. Use it to navigate 
among drives, directories and files in your system, and to select the files you wish to place in
the playlist.

Playlist box

Once you've created a list of files in the Playlist box at the right of the playlist window, you 
return to the main screen. Click on the Play button to play the Video files in the Playlist.

Buttons

Add: Adds the highlighted file(s) to the playlist.



Add All: Adds all the files currently listed in the Name list box to the playlist.

Delete: Removes the highlighted file(s) from the playlist.

Delete All: Removes all files from the playlist.

OK: Closes the Playlist window and returns to the main screen, with the playlist loaded.

Cancel: Closes the Playlist window and returns to the main screen, without updating the 
playlist.

Load: Activates a dialog box from which you can open an existing playlist file.

Save: Activates a dialog box from which you can save the current playlist as a file.

Tutorial
Making a Playlist

To use VideoStation, you must always make a playlist, even if it only contains one file.

To create a playlist:

 1. Click on the Playlist button at the lower left corner of the screen. The Playlist window 
appears.

 2. Use the drive and directory boxes in the center of the window to navigate to the drive 
and directory where the desired files are located.

 3. In the Type list box at the lower left, choose the desired file extension. The Files box will 
now display all the files in the current directory that have the selected extension.

 4. In the leftmost box, double-click on the desired file. The filename will be added to the 
playlist in the box to the right.

 5. Repeat the steps above to complete your playlist.

 6. Click the OK button to return to VideoStation's main screen.

To view the Video files in the playlist:

Click on the Mode button to select one of the four available playback modes:

Playlist - Plays video files in the order that they appear in the playlist, starting with the 
currently selected file, and stops after the last file.

Shuffle - Plays the files in the playlist in random order, continuing until you click the stop
button or close VideoStation.

Loop - Plays all the files in the order in which they appear in the playlist, starting with 
the currently selected file, then repeats the list from the beginning. This process continues 
until you click the stop button or close VideoStation.



Single - Plays the current selection in the playlist, stops when play is complete.

 7. Click on the Play button. The file(s) in your playlist will begin playing. The order of 
playback will depend on the current playback mode.

 8. Use the volume slider to adjust the sound level if you wish.

 9. To go immediately to the previous or next Video file in the list, click on the Previous or 
Next selection buttons.

 10. To halt playback before the playlist is finished, click on the Stop button.

NOTE: Note: Any Windows applications that are set to "Always on Top" will remain visible 
during playback.

To save a playlist:

 1. Click on the Save button in the playlist window.

 2. Navigate to the directory where you'd like to keep your playlist.

 3. Type a filename in the Files box. By default, Video playlists are saved with a *.VVL file 
extension.

To load an existing playlist:

1. Click on the Playlist button in the lower right corner of the main screen to open the Playlist
window.

2. Locate the Load button at the lower right corner of the Playlist window and click on it.

3. Navigate to the drive and directory and double-click on the desired playlist filename.

Editing playlists

It's easy to rearrange the order of the files in a playlist if you keep these simple rules in 
mind:

At least one line is always highlighted in the playlist box.

Items (or groups of items) are always inserted above the highlight.

To insert items in a playlist:

 1. In the Playlist box at right, highlight the line just below where you want to insert an item.

If you want to add an item to the bottom of the playlist, highlight the blank line below the 
last item in the list.

 2. In the box at the left, double-click on the desired filename or track, or click on the Add 
button.

To insert multiple items:

 1. Select an insertion point in the playlist, as described above.



 2. In the box at the left, select the items you wish to add:

To select a group of consecutive file names, click and drag your mouse up or down over 
the desired file names.

To select a group of non-consecutive file names, hold down the [Ctrl] key as you click on 
individual file names.

 3. Click on the Add button.

To insert all the matching files in the current directory, click on the Add All button.

To delete items:

 1. In the playlist box at right, select the item you wish to remove.

 2. Click on the Delete button.

To remove all the files from the playlist, click on the Delete All button.

NOTE: Delete operations can only remove files from a playlist. There is no danger of erasing 
files from your hard disk.

To close VideoStation:

Click on the Power (I/0) button on the Power Bar at the top of the screen.



 Imagestation- Image Viewer & 
Presentation Application 
Built around an interface that looks like a 35mm slide viewing table, ImageStation offers a 
quick and easy way to create presentations and slide shows on the PC. 

Main Screen Layout

ImageStation's Main Screen displays your graphic images along with readouts of their file 
names, statistics and descriptions, and incorporates controls which let you work with 
groupings of    slides, called Viewlists, add sound to them and, finally, play the Viewlist as a 
slide show.

Displays

Slideview Window: Displays scaled down, or thumbnail, views of    your graphic image files
that look like mounted 35mm slides. If    there are more than eight slides, a scroll bar 
appears at the right side of the window so that all can be viewed.

To select a slide, click on it. A red border appears around the image. To view the selected 
image full-screen, double-click anywhere on the slide or click the "Display Image" button 
below the Slideview window. The small microphone at the top of the slide enables you to add
sound which will play back during the Slide Show.

Viewlist: Displays the name of the current Viewlist selected in the Viewlist dialog box. If you
haven't yet saved the Viewlist under a unique filename, this entry will read: "Untitled."

Image #: The first number shows the position of the selected slide in the Viewlist. The 
second number, after the colon, shows the total number of slides in the Viewlist. 

Description Window: Shows the filename of the currently selected slide followed by any 
descriptive text you may have entered.

Buttons

Power: Closes the program.

Help: Opens ImageStation's help system, complete with graphics and explanations of all the
different screens you'll encounter in the program.

Music: Opens a dialog box allowing you to choose a MIDI file or CD audio track to play as 
background to your slide show. 

Describe: Opens a dialog box in which you can enter a brief text description for each 
image.

Viewlist: Opens a dialog box in which you can create, edit and save Viewlists.

Display Image: Displays a full-size image of the currently selected slide, in full screen 
mode, same as double-clicking on the slide. To return to Slideview, click anywhere on the 
screen.



Run Slideshow: Displays each image shown in Slideview, starting with the currently 
selected slide.

Manual/Auto: If you select "Manual", the display will pause after each slide until you click 
the mouse. In "Auto" mode, all the slides will play starting with the currently selected slide. 
The arrows to the right of the "Auto" check box allow you to set the interval between slides 
in seconds.

Supported Graphic File Formats

ImageStation supports almost all of the graphic file formats in current use. See the chart 
below for details.

Format
DOS File Extension

 Windows Bitmap
 *.bmp, *.rle

 Zsoft PCX
 *.pcx

 Kodak Photo CD
 *.pcd

 CompuServe GIF
 *.gif

 JPEG
 *.jpg, *.jff, *.jtf

 TARGA
 *.tga

 Tagged Image File
 *.tif

 CALS Raster
 *.cal

 MacPaint
 *.mac

 GEM Image
 *.gem



 Microsoft Paint
 *.msp

 WordPerfect Graphics
 *.wpg

 SUN Raster
 *.ras

 Macintosh PICTURE
 *.pct

 PostScript Raster+
 *.eps

 LEAD
 *.cmp

+ ImageStation can only display the raster image header included in an .EPS file. Not all .EPS 
files contain image headers.

Tutorial
Displaying Images 

Before you can display any images on the Main Screen, you will need to create a Viewlist of 
the slides you want to include in your show.    To do that, you open the Viewlist window.

Viewlist Dialog Box 

 1. Click on the Viewlist button at the lower left corner of the screen. The Viewlist dialog box 
appears. 

 2. Use the drive and directory boxes in the center of the window to navigate to the graphics 
files you want to display .

 3. Picking a particular file extension, like "bmp", in the File Type box at the lower left will 
ease the search. Only files with the "bmp" extension will appear in the Name box.

 4. Click on a file to select it. To select multiple files, hold down the Control key while clicking 
on each filename.

 5. Click the ADD button. The selected files will be placed in the Viewlist box on the right.

 6. To add all of the files in the "Name" box to the Viewlist, click on the "Add All" button.

ALERT: Warning: If you select non-graphics files for your Viewlist, ImageStation will attempt 



to create thumbnails for these files, placing blank slides on the Slideview screen and 
inserting blacked-out screens in your slide show. To avoid this, be sure your Viewlists include 
only the supported graphic file types.

 7. Click the OK button at the top of the Viewlist dialog box. The "Create Thumbnails" screen 
appears as your image files are being processed. You can click the Cancel button to stop the 
proceedings at any point.

When all the slides have been created, the main screen is restored and all the images in the 
Viewlist appear in the Slideview window.

Running a Slide Show

With all the slides now on the Slideview screen, you're ready to run the show.

To run a slide show:

 1. Select the thumbnail for the image you want to appear first in your slideshow.

 2. Select a mode: Click on the Manual or Auto button at the lower right. If you select Auto, 
use the numerical controller to the right of the Auto button to set the time interval between 
images.

 3. Click the Run Slideshow button. Each image will be displayed in order, beginning with the
selected image, and continuing to the end of the Viewlist. Upon completion, the Image 
Player module returns to the screen.

In Manual mode:

 To advance to the next image in the Viewlist, click the left mouse button anywhere on 
the screen.

 To display the previous image in the Viewlist, click with the right mouse button.

 4. To stop a slideshow before the end, press the Escape key.

NOTE: Note: Any Windows applications that are set to "Always on Top" will remain visible 
during the slide show.

Adding Sound 

ImageStation allows you to add sound narration to your slides and to simultaneously play a 
selected MIDI file or CD Audio track as background music throughout the slide show. Not all 
sound cards support simultaneous sound reproduction, so check the manufacturer's 
instructions to determine if you can access this feature.

To add background music to the Slide Show:

 1. Click the Music button to open the Music Dialog box. 

 2. In the Music dialog box, click the MIDI or CD button to choose a sound source.

 MIDI Click the Browse button. In the File Open dialog box navigate to the desired MIDI 
file and click on it. 



CD Audio Place the desired disk in the CD-ROM drive and select the track number you 
want.

 3. Click the Run Slideshow button to begin the show. If you've selected MIDI, the music will 
slowly fade out as the last slide plays, bringing your slide show to a neat close.

To add sound to a slide:

 1. Click on the microphone symbol to open the "Narrate" dialog box.

 2. When you're ready to record, click on the Record button. The red light flashes to indicate 
record standby mode and the status box display changes from "Stopped" to "Stand By".

 3. Click on the Play button to begin the recording. The red light remains lit, the "Current" 
box displays the elapsed time and the status box now reads "Recording." Speak into the 
microphone.

 4. When you've finished recording, click the square stop button. 

If you're not satisfied with your recording, click again on the Record button and repeat the 
process. The new recording will be written over the old one.

 5. For more detailed editing, click the Edit button, This opens a digital audio editor, WinDAT, 
and gives you full editing control over your recording. See your WinDAT documentation for 
full details.

 6. When you're happy with your recording, click the Accept button. You are returned to the 
Main Screen with the microphone symbol on the selected slide now shown in red. This 
recording will always play when the slide is displayed as part of a slide show. Repeat the 
above steps for any other slides to which you want to add sound. 

To remove a sound file associated with a slide:

 1. Click on the microphone symbol. 

 2. Click the Delete button in the Narrate Dialog Box.

This will restore the microphone symbol to its original black color and enable you to make a 
new recording for the slide.

To attach text descriptions to slides:

 1. Click on the Describe button. A dialog box will appear, containing a copy of    the Viewlist, 
including any existing descriptions. The currently selected file will be highlighted.

 2. Place your cursor in the Enter Description window and type the desired text.

 3. To add more descriptions, click the Next button, or click on any other entry in the list to 
select it, then type your text in the Enter Description window.

 4. Click OK to return to the Slideview screen. As you select each slide, its description will 
appear in the window at the bottom of the screen. The descriptions will be saved as part of 
the Viewlist.

To save a Viewlist:



 1. Click on the Save button in the Viewlist window.

 2. Navigate to the directory where you'd like to keep your Viewlist.

 3. Type a filename in the Files box. By default, Viewlists are saved with a *.VIL extension.

To load an existing Viewlist:

 1. Click on the Viewlist button to open the Viewlist window.

 2. Click on the Load button.

 3. Navigate to the drive and directory and double-click on the desired filename.

Editing Viewlists

It's easy to rearrange the order of the files in a Viewlist if you keep these simple rules in 
mind:

At least one line is always highlighted in the Viewlist box.

 Items (or groups of items) are always inserted above the highlight.

To insert items in a Viewlist:

 1. In the Viewlist box at right, highlight the line just below where you want to insert an item.

If you want to add an item to the bottom of the Viewlist, highlight the blank line below the 
last item in the list.

 2. In the box on the left, double-click on the desired filename or track, or select one or more 
files, and click on the Add button.

To insert multiple items:

 1. Select an insertion point in the Viewlist, as described above.

 2. In the box at left, select the items you wish to add:

 To select a group of consecutive file names, click and drag your mouse up or down over the 
desired file names.

 To select a group of non-consecutive file names, hold down the [Ctrl] key as you click on 
individual file names.

 3. Click on the Add button.

 To insert all the matching files in the current directory, click on the Add All button.

To delete items from a Viewlist:

 1. In the Viewlist box at right, select the item you wish to remove.

 2. Click on the Delete button.



 To remove all the files from the Viewlist, click on the Delete All button.

NOTE: Delete operations can only remove files from a Viewlist. There is no danger of erasing 
files from your hard disk.



    Sound Script - Animation and 
Presentation Player
Combine animation, bitmapped graphics, digital audio, MIDI song files and CD audio tracks 
to create exciting multimedia presentations. 

Main Screen Layout

Controls and Displays
Transport Controls
SoundScript uses Transport Controls common to many Voyetra Windows applications. The 
Previous and Next buttons move you from scene to scene.

If you need a more complete description of the transport controls, see the included 
"Common Controls" documentation file.

Loop Button: Sets presentation to play repeatedly.

Full Screen Button: Toggles full screen mode, which uses the entire screen to display your 
presentation.

Work Area
Scenes: Each numbered row comprises one scene    a related group of visual and sound 
events. A presentation is made up of one or more scenes.

Cues: A type of event that signals the end of the current scene and triggers the next.

Events: A cue, a graphic displayed on the screen or a segment of sound.

Menus
File Menu
New    : Opens a new, empty presentation file. 

Open : Open a presentation file. 

Save    : Saves the current presentation as a SoundScript .PSN file.

Save As...: Names and saves the current presentation as a .PSN file.

Exit    : Quits SoundScript.

File List (1 2 3 4): Allows single-click opening of the four most recently opened .PSN files 
(presentations).

Edit Menu



Insert Scene : Inserts a new, empty scene before the current scene.

Delete Scene    : Deletes the current scene.

Help Menu
Contents: Activates SoundScript's on-line Help system.

About SoundScript: Displays the program's revision number and creation date.

Sample Presentation
This edition of SoundScript includes a simple presentation file that you can run and examine 
to gain a sense of how presentations work. You'll find the file DEMO.PSN, in the same 
directory that contains SoundScript.

About .FLI Files
.FLI files (commonly called "flick" or "fly" files) conform to an industry-standard format for 
PC-based animation. The .FLI format was developed by Autodesk, Inc. for their line of 
Animator software products and is widely supported by other manufacturers. Animation files 
are available from Autodesk, from third-party suppliers and on many computer bulletin 
boards.

Tutorial
How SoundScript Works
SoundScript's work area is arranged as a grid. Each numbered row, or scene, controls one or 
more events. An event can be a cue, an image or an animation on the screen (a .BMP file or 
a.FLI or .FLC animation), or a sound (Digital Audio, MIDI, or CD Audio). You can run these 
events concurrently, and coordinate their timing with respect to each other to a precision of 
1/100th of a second.

Each Column in the work area is dedicated to one type of event. The first column manages 
cues  commands you use to control the flow of your presentation from scene to scene.

When SoundScript reaches the <<End>> scene, the presentation either terminates or loops
returns to the beginning and repeats continuously until you press the [Escape] key.

You can select Full Screen mode or a sizable display window. The window is best for editing 
your presentations. At show time, you will probably want SoundScript to use the entire 
screen.

To open and run the sample presentation:

 1. Choose Open from the File menu and navigate to the directory that contains SoundScript.

 2. Double-click on the DEMO.PSN file name to open the sample presentation file.

 3. Enable the Loop and Full screen buttons. (The green lights should be on.)



 4. Click on the Play button. 

As the sample presentation runs, you'll see animations and graphics accompanied by .WAV 
sounds (narration) and MIDI (music). If you don't hear WAV or MIDI file playback, check your 
mixer to make sure that the WAV and Synth outputs are set to adequate levels.

Notice that the Windows desktop disappears and the graphics occupy the entire screen. The 
presentation will repeat until you stop it (next step).

 5. To stop playback, press [Esc].

Creating a Presentation
There's no single formula for creating presentations, Use the five basic procedures that 
follow to build your presentation and tailor it to your needs.

Step One: Insert a Scene
To insert a blank scene:

 1. From the file menu select New. The new presentation will consist of a single scene, 
displayed in reverse video, with the word <<End>> in each of its five event boxes.

 2. Choose Insert Scene from the Edit menu, or press the [Ins] key. A new, blank scene 
appears above the <<End>> scene.

 3. Repeat the process to create several blank scenes. You can add or delete scenes at any 
time. Newly inserted scenes are always placed before the selected scene.

To delete a scene:

 1. Use the work area scroll bars or the Previous and Next buttons to bring the scene into 
view.

 2. Click on any event in the scene. This selects the entire scene.

 3. Select Delete Scene from the Edit menu, or press the [Delete] key.

Step Two: Add Events to the scene
You can place up to four events in each scene. In most cases, you'll want to show something 
on the screen then add sound.

To add an event to a scene:

 1. Double-click on the appropriate box in the scene (Graphics, Digital Audio, MIDI, CD 
Audio). A dialog box appropriate for that event type will appear.

 2. Click on the Browse button. From the Open dialog box, choose the file extension 
(.FLI, .FLC, .BMP, WAV, or .MID) if necessary Navigate to the proper drive and directory and 
double-click on the desired file name.

For CD Audio Tracks, follow the procedure below in the CD Selection List box: 



Click on the numericals to select the CD Track. 

To play only part of the track, choose an appropriate Start Time, and/or an End Time. 

To play the entire track, select 0:00.00 as the Start Time and "Track End" as the End 
Time.

In the example above, SoundScript will play the 4th track of whatever disk is in the CD-ROM 
drive. You must make sure that the correct disk is in the drive as you edit and play your 
presentation.

Step Three: Configure the events
Now you need to adjust some settings to control how each event is presented. Depending on
the type of event, however, these settings will vary. Two settings, Delay and Loop, are 
common to all events:

To set delay and loop for an event:

 1. To make an event within a scene start after the scene itself has begun, use the Delay 
numerical to set an appropriate interval in Minutes:Seconds.Hundredths of Seconds.

 2. To make the event occur more than once, set Loop to the number of repetitions you want.
If you choose "Forever" (It's where zero would normally be), the event repeats continuously 
until a subsequent command stops it.

 3. For graphics files, set the other options as described below.

 4. Click OK. The event box will now display the file name or CD track number and the 
playback parameters you selected.

Additional graphics parameters

A Graphics event can consist of an animation in .FLI or .FLC format, or a still graphic in 16-
color or 256-color .BMP format. For animation files, you can specify the following:

Color Cycling : Controls color palette animation in Display Window mode. When Color 
Cycling is enabled, color entries are reserved by the animation player when it detects that 
the colors are changing. Although Color Cycling allows for more accurate color rendition, it 
can generate pauses in playback.

Use All Colors: Controls color palette animation in Display Window mode. When Color 
Cycling is enabled, the Use All Colors option causes the animation player to reserve all color 
entries. When Color Cycling is disabled, Use All Colors has no effect.

Load in Memory: Allows the entire animation file to load into memory when opened. This 
helps an animation to play back more smoothly and more efficiently than those that must be
loaded from disk. In most cases, this option is only necessary with very large animations, 
those using high frame rates, or if you're using a slow CD ROM drive.

Speed: Sets the playback speed of the animation in Frames per Second. If you set the 
Speed to Default, the animation file will play back at its original frame rate.

Transition In: Determines the effect for the start of the animation: Cut, Fade from Black, or 



Fade from White. For fades, you must set a time interval.

Transition Out: Determines the effect for the end of the animation: Cut, Fade to Black, or 
Fade to White. For fades, you must set a time interval.

Step Four: Cue the next scene
The cue is the event that signals the end of the current scene, and instructs SoundScript to 
begin playing the next. For example, if you select .WAV as the cue in scene 4, scene 5 starts 
the moment that the WAV file in scene 4 has finished playing.

You can select any event in the scene as the cue, or you can select Time to specify the 
duration of the scene independently of any event.

Often, as a scene begins, events from earlier scenes are still in progress. You need to decide 
whether these other events should stop or continue.

To create a cue:

 1. Move to the desired scene and double-click on the Cue event box. The Cue Select Box 
appears.

 2. In the Cue: column, click on a button to select the event in the scene whose end will cue 
the next scene, or select Time and use the numerical to set the duration of the scene.

 3. Click on either the Stop or Continue button for each event type in the previous scene.

 4. Click OK.

Step Five: Fine-Tune your presentation
Continue with the steps above until you've assembled your presentation in rough form. From
here you can edit any of the settings anywhere in your presentation. This is largely a trial-
and-error process and your decisions will be based on the requirements of your presentation 
and your personal tastes. Here are some general pointers:

Playback always begins with the currently selected scene.

Disable the Full Screen button. This runs your presentation in a sizable window, and 
allows you to see and use the SoundScript workspace and transport controls.

As the presentation runs, the inverse highlight in the work area moves downward, so you 
can always see which scene is currently playing.

You can pause the presentation, scroll forward and backward, and monitor the progress 
from scene to scene as the presentation runs. 

Be sure to select a cue for every scene (including the last scene).

Be sure that each cue is valid. If you select a cue for which there is no event, SoundScript
will either proceed immediately to the next scene or halt.

Be sure the presentation doesn't contain any blank scenes. This will cause the 
presentation to halt.



Don't use an event that's set to Loop forever as a cue.

If you can't make an event fit smoothly into your presentation, use the appropriate 
program to edit the event itself. For example, you could use an editor such as MIDI 
Orchestrator to shorten a MIDI file by increasing its tempo.

To preview a presentation:

 1. Disable the Full Screen button if necessary.

 2. Arrange your Windows desktop so you can see the Display Window and SoundScript's 
transport buttons and work area.

 3. Use the Previous or Next buttons to move to and select the scene where you would like 
playback to begin.

 4. Click the Play button.

 5. To pause the presentation at any point, click on the Pause button.

 6. To stop playback, click on the Stop button.

To adjust event parameters:

 1. Scroll to and select the desired scene.

 2. Double-click on the desired event.

 3. From the dialog box, change the file name, track number, or playback parameters as 
needed.

 4. Click OK.

It's a good idea to save your presentation frequently as you work, and when it's completed. 
SoundScript files have a .PSN extension.

To save a presentation:

 1. Choose Save from the File menu.

 2. If you're saving a new file, the Files dialog box will appear and you'll be prompted to type 
in a file name.

 3. Choose OK from the Files dialog box to save the file.

Considerations for Playing Animation Files
SoundScript uses the Autodesk Animation Player for Windows as its playback and display 
engine for .FLI and .FLC animation files and bitmaps in the .BMP format. When using 
SoundScript to play animation files or display bitmaps, you should keep in mind the 
considerations outlined below.

Non-Standard VGA Drivers



Problems may occur when running full-screen animations along with a non-standard VGA 
driver; i.e.: anything other than the Windows 3.1 VGA driver. 

If you're using a proprietary driver for your video card and you experience problems playing 
full-screen animations (animations hanging-up, not returning from Full Screen mode or 
failure to restore the color palette when done), try adding the following line to the [386Enh] 
section of your SYSTEM.INI file:

EMMExclude=A000-AFFF

In any event, adding this line to your SYSTEM.INI should not have any adverse effects.

The WIN.INI File
The Autodesk Animation Player uses a special driver called AAVGA.DLL to display animations
in Full Screen mode. In order to play full-screen animations, the following entries must be 
included in your WIN.INI file: 

 [AAPLAY Animation]  FullScreen=AAVGA.DLL  DualScreen= (value)

In most cases, these entries are automatically added to the WIN.INI file after playing a full-
screen animation. As long as AAVGA.DLL is in either your path, your \WINDOWS directory, or 
your \WINDOWS\SYSTEM directory, and as long as DualScreen=0, these entries do not need 
to be edited. 

If AAVGA.DLL is located in another directory, the full path must be specified in the above 
section of the WIN.INI file.

If you're using a dual-screen display setup, change the DualScreen value to 1.

There is another optional entry for the [AAPLAY Animation] section of the WIN.INI file which 
may help to alleviate certain full-screen problems. Try adding:

Int2fSwitch=yes

The Int2fSwitch entry can actually cause video problems in some cases. If this happens, 
remove this entry from your WIN.INI file.

256-Color Animations and Bitmaps
You can display 640x480 animations and bitmaps only if Windows is currently using a 256-
color video driver. If a 16-color video driver is being used, the Autodesk Animation Player 
makes the assumption that your video card cannot support 640x480 mode.

In Display Window mode, the Animation Player can use a maximum of only 236 colors at one
time. (Windows reserves 20 of the 256 colors for the Windows desktop.)

Color Palette Management (Display Window mode only)
In Display Window mode, the Animation Player must negotiate with the Windows palette 
management system for proper color display. Two options, Color Cycling and Use All Colors, 
give you some degree of control over color palette management. 



Color Cycling

In display window mode, the Animation Player can be set to enable the Color Cycling 
feature. With this option turned on, your animation will run more quickly because the 
animation player software, which has been optimized for this function, takes over color 
management usually handled by Windows itself. The disadvantage in using this option is 
that the colors in any other Windows application running at the time are likely to be affected.

You can control this problem somewhat by turning off the Use All Colors setting in the 
Graphics Event Box.

To turn off the Use All Colors setting:

 1. In the Graphics Event dialog box, select Color Cycling.

 2. Toggle the Use All Colors Setting to Off.

Color cycling will now occur only when the palette of the animation file changes, normally 
when a new animation in a SoundScript presentation begins to play. This will give you 
smoother transitions between animations as your script runs. 

 3. Experiment with the other possible settings, turning Color Cycling and Use All Colors on 
and off as you run your animations to achieve the best balance between color and 
performance.



    Sound Events - Add Sound Effects to 
Windows
Trigger the .WAV sound of your choice any time you move or re-size a window, press a 
certain key on your PC keyboard, run a program, and more! 

Screen Layout

Category Buttons
System Events: Assigns sounds to the Start Up and Shut Down of Windows ( i.e.: when you
start or exit Windows).

Window Events: Assigns sounds to common Windows events such as re-sizing or moving a 
window, using a scroll bar, and so on.

Program Events: Assigns sounds to the startup of a specific Windows application.

Button Events: Assigns sounds to common Windows buttons such as OK, Cancel, Browse, 
Help, etc.

Keyboard Events: Assigns sounds to individual keys on the PC keyboard.

Events Window
Displays and allows you to choose all available events in the selected category.

Sounds Dialog Box
Use this box to navigate to, audition, and select .WAV files to associate with the currently 
selected event in the Events Window.

Tutorial
Sound Events is easiest to use if you place it in your Startup group so it loads automatically 
and begins watching for Windows events. (The installation program may have done this for 
you already.)

If Sound Events doesn't start automatically, you'll need to start it as you would any Windows
application, in order for it to work.

Once you've configured Sound Events, it works unattended so you'll probably want to modify
its program item Properties to run it as a minimized application. For information on adding 
programs to your Startup group and changing program item Properties, refer to your 
Windows Users Guide.

To assign sounds to system events:

 1. Run (or maximize) Sound Events by double-clicking on its icon.

 2. Click on one of the five event Category buttons at the upper left of the window. The 



Events box will display the list of available events in that Category.

If you choose Programs, a dialog box will open from which you can select from among your 
installed Windows applications.

 3. Select the event or program to which you'd like to attach a sound.

 4. In the Sounds Dialog Box at the bottom of the Sound Events window, navigate to 
the .WAV file you want to associate with the event that you selected in the previous step.

To hear a .WAV file, highlight it and click on the Audition button. If the Auto Audition buttonis 
activated, you'll hear each file play as you highlight it.

 5. Continue the process above, selecting events and .WAV files to go with them. Your 
choices are automatically saved as you make them.

 6. When you're finished, Click OK.

To remove sounds from events:

 1. Follow the procedures described above to select the Category and Event.

 2. From the Sounds list box, choose <<none>> as the sound.



 SayIt! - OLE Sound Annotation Application
Press a hot key, speak into your microphone, click a button. With Say It! that's all it takes to 
place audible voice notes into documents created with Windows Write, Word for Windows, 
Microsoft®,    Excel®, Lotus®, AmiPro®, or any other application that supports Object 
Linking and Embedding.

Screen Layout

Controls and Displays

Transport Buttons
Say It uses Transport Controls common to many Voyetra Windows applications. If you aren't 
familiar with their operation, see the included "Common Controls" documentation file.

Scroll bar 
During recording, the thumb, the square box inside the scroll bar, shows how much of the 
maximum recording time you've used. (See "Maximum" below.)

During playback, the thumb shows the current position relative to the length of the 
recording.

Time Indicators
Maximum: Displays the maximum allowed length of a voice note, in Minutes:seconds.

Current : Displays your current position in the file in minutes:seconds. 

Status Indicator
Shows what Say It is doing: "Record Standby", "Recording", "Playing", "Paused" or "Stopped".

Accept/Cancel Buttons
Accept: Stops recording and automatically embeds the voice note into the selected 
destination (the most recent cursor location) in the client application.

Cancel: Erases the current recording and returns Say It to its minimized state.

VU Meter
A vertical column of "lights" at the right edge of the Say It window that flash to display 
playback or record levels.

Menus

Edit Menu
Copy: Places the current recording into the Windows Clipboard.



Paste: Places digital audio data from the Windows Clipboard into Say It.

Setup Menu
Auto Record: If selected, recording begins the moment you activate Say It. Otherwise, Say 
It waits until you press the Record button, then the Play button.

Hot Key...: Sets the hot key combination that activates Say It.

Maximum Length...: Sets the maximum length of your voice notes. Default length is one 
minute.

Always on Top: Keeps the Say It window or icon on top of any other Windows applications 
that are running.

Record Settings: Sets or changes digital audio settings for sample rate, data format and 
mono/stereo supported by your sound card.

Help Menu
Activates the on-line help system.

Tutorial
Say It embeds audible sound, or voice notes, into OLE clients documents created in 
applications that support Windows Object Linking and Embedding.

If you find these terms puzzling, don't worry. Say It is specifically designed to simplify OLE, 
so you can start using it right away. Just remember that the client is the document into 
which you place your voice note. Windows Write, Word for Windows, Microsoft Excel and 
Lotus AmiPro are all examples of OLE client applications. New ones are being released all the
time.

Say It is easiest to use if you place it in your Startup group, so it's automatically loaded and 
always ready on your Windows desktop. (The installation program may have done this for 
you already.) If Say It doesn't start automatically when you load Windows, you'll need to 
start it, as you would any Windows application, before you can use it.

Either way, Say It always loads as a minimized application. It appears as a icon on your 
Windows desktop until you activate it.

Recording Voice Notes

To prepare for recording:

 1. Connect your microphone to the appropriate input on the sound card and use your mixer 
to adjust the record level to a comfortable value.

 2. Make sure Say It is loaded; the icon should be visible on your Windows desktop.

 3. Use your OLE client application to create or open a document. Your client application will 
display a new menu item in its system menu: "Record Note Ctrl-R."

The instructions that follow make certain assumptions about how OLE clients work. A few 



OLE client applications may work differently. If so, check the documentation for your 
application to find out how it works with OLE objects.

To record and embed a voice note:

 1. In the client document, place your cursor at the desired destination for your voice note.

 2. Get ready to speak into the microphone.

 3. Activate Say It by pressing the Hot Key, [CTRL]-R. The Say It screen will appear and 
recording starts immediately.

 4. Speak into the microphone.

 5. When you've finished speaking, click on the "Accept" button.

 6. Say It will return to its minimized state and your voice note will be automatically 
embedded at the destination point you selected. A copy of the Say It icon will mark the 
location of your voice note.

Other Recording Tools

Say It gives you several ways to recover from mistakes and to make sure you're satisfied 
with your recording before embedding it.

To pause during recording:

 1. Click on the Pause button to temporarily halt recording without erasing the material 
you've already recorded. 

 2. Press the pause button again to resume recording from the point at which you paused. 
(You can also use the Spacebar in place of the Pause button.)

ALERT: Use only the Pause button (or the Spacebar) to resume recording. If you click the 
Record button, you'll erase the existing recording and start a new one.

To listen to a recording before you embed it:

 1. Click on the Play button to hear what you've just recorded.

 2. If you're satisfied, click on the Accept button to embed the voice note.

To re-record a voice note:

 1. Click on the record button. The red light on the record button blinks to indicate that Say It
is in Record Standby mode.

 2. Click on the Play button. Say It deletes the first recording and starts making a new one in 
its place. You can repeat this process as often as you need to.

 3. Press the "Accept" button when you are satisfied with your recorded message.

To cancel a voice note:



Press the Cancel button (or the [C] key) at any time. The current recording will be erased 
and Say It will return to its minimized state.

Playing Voice Notes

You, or anyone else who has a properly installed copy of Say It, can play back your voice 
notes.

To play a voice note:

 1. In the client document, double-click on the Say It icon, or select the icon and choose "Say
It Object", then "Play" from the document's Edit menu. You will hear the voice note play.

 2. To stop playback, click the left mouse button.

To play back from a point other than the beginning, drag the thumb on the scroll bar to the 
desired position, then press the Play button.

Changing Voice Notes

There are two ways to change a voice note after it has been embedded in a document. You 
may cut, copy or move it to a new location in the same client or in another client, and you 
may replace an existing voice note altogether.

To cut, paste, or delete voice notes:

 1. Select the voice note icon embedded in your document.

 2. Use the client application's Cut or Copy command in the normal manner. 

The voice note is now in the OLE client's Clipboard. You can paste it to a different point in the
same document, or into another OLE client document.

To replace an existing voice note:

 1. Select the Say It icon embedded in the document.

 2. Activate Say It, or choose "Say It Object", then "Edit" from the client application's Edit 
menu.

 3. When Say It starts, record your new version of the voice note.

 4. Click on the "Accept" button.

Your new voice note will replace the existing one.

Editing Voice Notes

Say It does not permit you to edit your voice notes directly. However, you can transfer voice 
notes into a Digital Editing Program such as WinDAT for editing, or you can convert existing 
digital audio files into voice notes.

ALERT: Any time you use WinDAT and Say It together, keep WinDAT open until you have 
completed the entire process. WinDAT holds the data in a private clipboard during some 



steps.

To edit a voice note with    the digital editing program:

 1. Select the voice note in the OLE client document.

 2. Choose "Say It Object", then "Edit" from the client application's Edit menu. The Say It 
window will appear.

 3. From the Say It Edit menu, select Copy.

 4. Switch to the digital editing program and select Paste from the Edit menu. The voice note
will load into the digital editing program.

 5. Edit the file in the digital editing program.

 6. From the digital editing program Edit menu, choose Select All, then Copy.

 7. From Say It's Edit menu, select Paste.

A copy of the edited voice note is now loaded back into Say It.

 8. Select "Accept." The edited voice note replaces the original in the client document.

To convert a digital editing program file into a voice note:

 1. Place your cursor at the desired destination in the OLE client application.

 2. From the OLE Client, activate Say It. 

 3. Use the digital editing program to open an existing file or to create a new one.

 4. Select the part of the file you wish to embed in your OLE client. To embed the entire file, 
choose Select All from the Edit menu.

 5. From the digital editing program Edit menu, select Copy.

 6. From the Say It Edit menu, select Paste.

 7. Click on "Accept." Say It will embed the file in the OLE Client.

Say It! and Non-OLE Applications

If you try to embed a voice note in an application that is not an OLE client, the procedure will
fail and it will appear that your recording has been lost. You can retrieve it if you follow these
steps right away. If you use any command that places new data in the Windows Clipboard 
(e.g., Cut, Copy), re-activate Say It, or exit Windows, you will not be able to recover your 
voice note.

To retrieve a "lost" recording:

 1. Switch to the application into which you want to embed your voice note. Be sure that the 
application is an OLE client.



If no OLE clients are running, you may start one. Windows Write is a good choice.

 2. Place your cursor in the desired position.

 3. From the client's Edit Menu, select Paste.

The voice note will be pasted at the location of the cursor. 

 4. You can now save the file if you wish, or cut, copy or move the voice note to its final 
destination in an OLE client application.

Customizing Say It!

You might want to change the Hot Key combination that activates Say It, particularly if 
another application uses the same combination.

To change the Hot Key:

 1. From the Setup Menu, select "Hot Key." A dialog box will appear.

 2. Use the check boxes to turn Alt or Shift on or off as desired. The Hot Key combination 
always includes the Control key, and a letter or numeral key. The example illustrated here 
shows a Hot Key setting of [Ctrl]-[Shift]-V.

 3. To change the letter, drag your cursor across the character in the "Key" box to select it. 
Type a single letter or numeral of your choice. You cannot use punctuation or other special 
characters.

 4. Click OK.

To adjust the maximum length of voice notes:

 1. From the Setup menu, choose Maximum Length.... The Maximum Length dialog box will 
appear.

 2. Use the Minutes:Seconds numerical to adjust the time as desired.

 3. When you've finished, choose OK.

By default, Say It records in 8-bit mono at 11.025 KHz    a format supported by almost all 
digital audio hardware and software. However, if you send voice notes to someone whose 
system has different requirements, or if you want to take advantage of file compression, you
can change these settings.

To change digital audio parameters:

 1. From the Setup menu, select Record Settings...

 2. In the dialog box that appears, select the desired sample rate, data format and 
stereo/mono setting. Check your soundcard's manual for details on its capabilities.

 3. Click OK.



    Audio Calendar - Calendar/Scheduler
Use text, voice messages and audio alarms to keep track of your daily appointments. Audio 
Calendar displays an entire month with special events noted. A quick double-click gives you 
a closer look at any day's activities.

Screen Layout
Month View Display

Month View displays all the days of a particular month arranged in a familiar grid fashion, 
just like a desk calendar. You can choose between two display modes:

Window mode: In Window mode, the Month View acts as a window which can be sized, 
minimized, or maximized like most other Windows programs.

Blotter mode: Audio Calendar resembles Windows Wallpaper; it fills your entire Windows 
desktop and remains behind any other applications, windows, or icons.

Month View Menu

The Month View does not have a conventional Windows menu bar. Click with the right mouse
button anywhere on the Month View to open its single, drop-down menu containing the 
following items:

Next: Advances the Month View to the next month. Shortcut: double-click on the small 
calendar at the top right.

Prev: (Previous) Displays the previous month. Shortcut: double-click on the small calendar 
at the top left.

Go To...: Lets you select any month and display it.

Today: Returns the Month View to the current month.

Show Day View: Opens today's Day View window. (See "Day View" section below.) 
Shortcut: double-click on the desired day in the Month View.

Customize Title: Lets you customize the title which appears at the top of the Month View.

Start Week On...: Configures the Month View to start on any desired day of the week. 

Clear Events: Removes all the appointments and their attached reminders within a 
specified period of months/years. Allows you to remove audio messages (Wave files) only, if 
you wish.

Blotter/ Restore To Window: Toggles the Month View between Blotter and Window mode.

Exit: Quits the Audio Calendar.

Day View Controls and Displays

Appointment list: Allows you to list appointments in half-hour time blocks.



Message Recorder: Records and plays audio messages, which you place in the 
Appointment list. Displays the digital clock.

Notes field: Allows you to    enter more detailed information about individual appointments.

Calendar Event Field: Allows you to enter an event for display in that day's square in the 
Month View.

Day View Menus

File Menu
Data Directory: Selects the directory where the Audio Calendar will store its data files 
(audio messages, appointments, text, etc.).

Clear Events: Removes all the appointments and their attached reminders within a 
specified period of months/years. Allows you to remove audio messages (Wave files) only, if 
you wish.

Remove Audio Message: Removes the audio message from the currently selected time 
block.

Close: Closes the Day View and returns you to the Month View.

View Menu
Next: Advances the Day View to the next day.

Prev: (Previous) Rewinds the Day View to the previous day.

Go To...: Lets you access the Day View for any day.

Today: Returns the Day View to the current day.

Alarm Menu
Set: Toggles the alarm on and off for the currently-selected time block.

Defaults...: Selects the Pre Alarm Time and the Wave file to use for the alarm.

Help Menu
Contents: Activates the Audio Calendar's on-line help system.

About Audio Calendar...: Displays the program's revision number and creation date.

Tutorial
The Voyetra Audio Calendar uses your PC's Clock/Calendar    as its reference source. Use the 
Date/Time utility in the Windows Control Panel to set the clock if necessary. See your 
Windows documentation for details.

Month View



To use the Month View menu:

 1. To open the menu, click the right mouse button from anywhere in the Month View.

 2. To move the menu, click with the right mouse button. The menu's upper left corner will 
jump to the mouse pointer.

 3. To close the menu, click the left mouse button anywhere outside the menu.

To select Blotter or Window mode:

 1. Click the right mouse button to open the menu.

 2. Choose Blotter or Restore to Window.

To display a different month:

Choose Next or Previous from the Month View menu. Shortcut: double-click on either of the 
small calendars near the top of the Month View.

To move directly to a specific month and year:

 1. Choose Go To... from the Month View menu.

 2. In the dialog box, choose the desired month from the drop down list box.

 3. Use the Year numerical to change the year, if necessary.

 4. Click OK.

To return to the current month and day:

Choose Today from the Month View menu. The Month View will return to the current month 
with the current date displayed in inverse video.

To customize the title:

 1. Choose Customize Title from the Month View menu. Shortcut: double-click on the current 
title.

 2. In the dialog box that appears, type the desired text into the Title Line 1 and    Title Line 2 
boxes, and Click OK.

To set the first day of the week:

 1. Choose Start Week On... from the Month View menu.

 2. In the Start Week On... dialog box, choose the desired day from the list box. 

 3. Click OK. The calendar grid will now start each week with the chosen day.

Day View



The Day View gives you a more detailed look at each day's activities.

To access the Day View:

 1. If necessary, scroll to the desired month as described above.

 2. Double-click on the square representing the desired day. 

 3. Once you're in the Day View, you can switch to another day by choosing Next, Prev, or Go
To... from the View menu. Shortcut: Click on the scroll arrows at the upper right of the 
appointment list to move forward or backward by one day.

To return to Month View:

Chose Close from the Day View's File menu, or double-click the system menu button in the 
upper left corner.

Calendar Events
Text you type in the Calendar Event window appears in the corresponding square of the 
Month View.

To insert a calendar event:

 1. Enter the Day View for the desired day.

 2. Click on the Calendar Event box.

 3. Enter a line of text.

Appointments
You can enter an appointment for any half-hour increment of time, and attach various types 
of reminders and messages to each one.

To enter an appointment:

 1. Access the Day View for the desired day.

 2. If necessary, use the scroll bar to bring the desired portion of the day into view.

 3. Select a line in the appointment list and enter a brief title for the appointment.

Text Notes
You can attach a more detailed text note to each appointment.

To attach a text note to an appointment:

 1. Select the desired appointment. 

 2. Click on the Notes box and enter your text. There is space enough for about 165 
characters.



A pencil icon identifies each appointment that has attached text. To view the note for an 
appointment, highlight the line in the appointment window.

Alarms
You can set an alarm for any appointment at any time. When the alarm goes off, a window 
pops up, displaying the appointment, its time and its text note, if you entered one.

For all this to happen, Audio Calendar must be running at the time the alarm is set to go off. 
(It's OK if Audio Calendar is minimized.) If Audio Calendar is not running at the time, a 
message will alert you to the expired alarm the next time you run Audio Calendar.

To set an alarm for an appointment:

 1. If necessary, use the scroll bar to bring the appointment time into view.

 2. Select the appointment time and choose Set from the Alarm menu. The bell icon will 
appear on the line next to the appointment. Shortcut: Double-click on the appointment.

 3. To remove an alarm, choose Set again from the Alarm menu, or double-click on the 
appointment.

Audio Calendar can remind you of appointments up to one hour in advance. This global 
control affects the alarm time for all of your appointments.

To set the Pre-Alarm Time:

 1. Choose Defaults... from the Alarm menu.

 2. Use the Pre-Alarm Time numerical to select the desired Pre-Alarm Time, and click OK. 

You can choose any valid .WAV file to use as the audio alarm for all your appointments. If 
you don't choose a .WAV file, you will hear the Windows System Event sound associated with
the asterisk or a beep from the PC speaker.

To choose the .WAV file for the alarm:

 1. Choose Defaults... from the Alarm menu.

 2. In the Alarm Defaults dialog box, select the Change Wave... button. A file dialog box will 
appear.

 3. Navigate to the drive and directory where the Wave file is located.

 4. Highlight the name of the desired file and click on the OK button. Shortcut: Double-click 
on the file name. This will return you to the Alarm Defaults dialog box.

 5. From the Alarm Defaults dialog box, click on the OK button.

The Play Message Option

Audio Calendar can automatically play the audio message (see below) associated with an 
appointment after it plays the alarm.



To play an audio message with the alarm:

 1. Choose Defaults... from the Alarm menu.

 2. In the Alarm Defaults dialog box, click on the Play Message button. The green light turns 
on to confirm that this option is active.

The Message Recorder

Audio Calendar lets you record and attach a unique .WAV file to each appointment. Audio 
messages typically consist of voice notes or other verbal reminders, but you can attach 
sound effects, music, or any recorded material you wish.

To prepare for recording:

 1. Make sure your microphone or other audio source is properly connected to your 
soundcard and working.

 2. Use your mixer to set the record level.

To record an audio message:

 1. From the Day View, click on the desired appointment. 

 2. Click on the Message Recorder's Record button. The red LED will blink, indicating that the 
Message Recorder is in Record Standby mode.

 3. Click on the Play button to begin recording.

 4. Speak into the microphone, or start your CD, tape, or other audio source.

 5. Click on the Stop button. Your recording will be attached to the current appointment and 
the audio message icon will appear on the line next to it.

To review, re-record or delete an audio message:

 1. In the Day View, select the appointment. 

 2. To hear the message, click on the Play button.

 3. To re-record your audio message, repeat the recording procedure. Your new recording will 
replace the original.

 4. To delete the audio message, choose Remove Audio Message from the File menu.

To clear events from Audio Calendar

 1. From the month view menu, select Clear Events.

 2. In the dialog box, select the month for the beginning and end of the time interval you 
wish to clear. Use the numerical to select the year, if necessary.

 3. Repeat to set the end of the time interval.



 4. If you wish to preserve the text portion of your entries, activate the Audio Messages Only 
button. The light turns on to confirm this option.

 5. Click OK. All entries are deleted from the time interval you selected. If the Audio 
Messages Only option was selected, the text entries will be preserved.

Keyboard Commands

You can control many of Audio Calendar's functions without using your mouse. The following 
chart summarizes the keyboard commands:

Function
Key

 View Next Month/Day
 [Ctrl]-N

 View Previous Month/Day
 [Ctrl]-P

 Go to Month and Day
 [Ctrl]-G

 Go to Today
 [Ctrl]-T

 Toggle Alarm
 F2

 Show Day View
 F3

 Close Day View/Exit
 [Alt]-F4

 Help
 F1

Automatic Saving Feature

Audio Calendar does not require you to open or save files. Information entered is 
automatically stored any time you move your cursor to a different window and the necessary
files are saved automatically when you exit the program.

If it appears that your appointments are not being saved, it's probably because the program 
is trying to save your data in an invalid or nonexistent directory, or in a valid directory with 



insufficient free space.

If you experience this problem, switch to the Day View, select Data Directory... from the File 
menu and be sure the directory is a valid one with free space.

Customizing Audio Calendar

 (For advanced users only)

You can customize certain aspects of Audio Calendar's user interface by adding or changing 
entries in the Audio Calendar initialization file, CAL.INI. Among the parameters you can 
customize are:

Starting time in the Day View

Time interval in Day View (1, 2, or 4 hours)

Automatically set alarm for every appointment

Day View background color

Month View title color

Font sizes and styles

The Voyetra software installation program copies a sample CAL.INI file onto your hard drive. 
This file includes instructions for customizing Audio Calendar. Copy this file to your Windows 
directory and edit it as needed in any standard ASCII text editor such as Notepad. The next 
time you run Audio Calendar, your changes will be reflected in the program's user interface.



    Voice Net - Voice Mail for Novell Networks
Voyetra Network Mail for Novell LANs ®
Send text and audio electronic mail among users on a Novell®Netware® 2.x, 3.x, or 4.0 Local 
Area Network (LAN). 

Portions of this program Copyright© 1983-1993 Novell, Inc. All rights reserved.

Screen Layout

Displays and Controls

Audio Transport
Transport Controls: VoiceNet uses Transport Controls common to many Voyetra Windows 
applications. If you aren't familiar with their operation, see the included "Common Controls" 
documentation file.

Clear Button: Clears the text message screen and optionally erases the current audio 
message.

Send Button: Displays the Send Mail To... dialog box in which you select one or more 
recipients for a message.

Message Counter: Displays the number of incoming messages waiting to be read.

Read Button: Displays the next incoming message in the work area. Messages are read in 
the order in which they were received.

Work Area
Displays incoming text messages and lets you enter your own text messages.

Status Display
Status window: Displays the current status of VoiceNet's audio transport (Playing, 
Recording, Record Standby, Paused).

Audio window: Indicates whether the current message includes audio (YES or NO).

Menus

Edit Menu
Note that the Undo, Cut, Copy and Paste commands operate only on the text portion of 
messages.

Undo: Undoes the most recent Edit command.

Cut: Deletes the selected text and copies it to the Windows Clipboard.

Copy: Copies the selected text to the Windows Clipboard.



Paste: Copies text from the Windows Clipboard into VoiceNet's work area.

Options Menu
Select Alarm File: Presents a dialog box to select the .WAV file to use as VoiceNet's alarm 
sound.

Alarm Sound: Toggles the Alarm Sound on or off.

Delete Current Audio File: Clears the current audio message from VoiceNet.

Help Menu
Contents: Activates VoiceNet's on-line Help system.

About VoiceNet...: Displays the program's revision number and creation date.

Tutorial
Hardware and Software Requirements

For VoiceNet's text functions to work, both the sender and the recipient must have properly 
installed copies of VoiceNet, and both must be able to log onto the same Novell®,    
Netware®, 2.x, 3.x, or 4.0 Local Area Network (LAN).

For the audio functions to work, both parties must also have Windows-compatible sound 
cards and a Voyetra digital audio editor (WinDAT) installed.

If you are not logged onto a Novell network and you try to run VoiceNet, you'll receive the 
message, "Cannot find NETWARE.DLL." VoiceNet will run and you'll be able to create a 
message, but you won't be able to send it to anyone. Log onto the network and start 
VoiceNet again. If the error message persists after you've logged onto your network, consult 
your system administrator.

Please note that the copy of VoiceNet bundled with this sound card may be installed and 
used on a single computer at any given time. Important information for your network system
administrator about licensing, installing and configuring VoiceNet is included at the end of 
this document.

ALERT: Because VoiceNet places messages on the network server, privacy cannot be 
assured. Experienced users will be able to read pending messages.

Tips for Running VoiceNet

VoiceNet is easiest to use if you place it in your Startup group so it loads automatically, 
ready to receive messages. (The installation program may have done this for you already.) If 
VoiceNet doesn't start automatically, you'll need to start it, as you would any Windows 
application, in order for it to work.

When you're not using VoiceNet to send or read messages, it's best to keep it minimized as 
an icon on your Windows desktop so you'll be notified of any incoming mail right away.

Sending Messages



To create a text message:

 1. If necessary, delete the text of any previous messages; highlight the text and select Cut 
from    the Edit menu.

 2. If you wish to save the cut text, you can paste it into another file.

 3. Click anywhere on the text box and enter your new message. You can type new text 
and/or paste text from the Windows clipboard. You don't need to address your message. 
When you send your completed message, VoiceNet will automatically insert the date, the 
time and the names of the sender and recipient.

To record a voice message:

 1. If necessary, connect your microphone to the appropriate input on the soundcard and use
your mixer to set the record level.

 2. Click on VoiceNet's Record button. The red LED will blink to indicate that VoiceNet is in 
Record Standby mode.

 3. Click on the Play button to begin recording and speak into the microphone. 

 4. When you have finished recording, click on the Stop button. Your recording will be 
automatically attached to the current outgoing message, and you'll see the word "YES" in 
the Audio window at the lower right.

 5. To review what you've just recorded, click on the Play button. Click on the Pause button to
momentarily halt playback. Click Pause again to resume.

To re-record your voice message, repeat the steps above. The new message will replace the 
current one.

To remove the audio message, choose Delete Current Audio File from the Options menu.

To send a VoiceNet message:

 1. Create the text and/or voice message as previously described.

 2. Click on the Send button.

The Send Mail To... list box will appear, listing all the users that have accounts on the file 
server.a

 3. Select the user(s) to whom you wish to send the message.

To select a single name, click on it with the mouse.

 To select a group of consecutive names, click and drag the mouse across the desired 
names.

 To select non-consecutive names, hold down the [Ctrl] key as you click on individual 
names.

 If you wish, you can send messages to yourself.



4. From the Send Mail To... list box, click on the Send button to transmit the message. 
Shortcut: To address and send a message to one recipient, just double-click on the 
recipient's name.

Receiving Messages

When someone sends you a message, VoiceNet notifies you as follows:

If VoiceNet is minimized, the mailbox flag on the VoiceNet icon waves up and down. If the
Alarm Sound is enabled, the designated.WAV file will play approximately every 5 seconds. 

If VoiceNet is enlarged to a window, the count in the Messages display increases.

If you're not running VoiceNet, VoiceNet will store the message and alert you the next 
time you run it.

To enable and select the Alarm Sound:

 1. From the Options menu, enable Alarm Sound. (It should be checked.)

 2. From the Options menu, choose Select Alarm Sound .

 3. Click on the Browse... button to find and select the desired.WAV file, then click OK.

To read and/or hear your messages:

 1. Double-click on the VoiceNet icon to enlarge it to a window if necessary. 

The Messages counter in the upper right portion of the VoiceNet window tells you how many 
messages you have waiting. 

 2. Click on the Read button to read the first message. The text of the first message, along 
with a header showing the time, date, the sender, and the recipient, will appear in the work 
area. 

 3. If the message includes audio, the word "YES" appears in the Audio window at the lower 
right and the audio message plays automatically.

To re-play the audio message, click the Play button. Use the Pause button to halt and resume
playback if you wish.

 4. Dispose of the message as necessary. (See next section.)

ALERT: If you want to forward, copy or save text, you must do so at this point    before you 
read the next message. VoiceNet will delete the current message when you read the next 
one.

 5. Click Read to display the next message.

Disposing of Messages

To save text from a message:



 1. Highlight the desired text and choose Cut from the Edit menu.

 2. Paste the text into another application that uses the Windows Clipboard (Write, Card File, 
Notepad, etc.).

To reply to, or forward a message:

 1. Edit the text, if you wish.

 2. To attach a new Audio message, use the record procedure described earlier. The newly 
recorded message will replace the existing one.

 3. To delete an audio message, select Delete Current Audio File from the Options menu.

 4. Send the message. Each time a message is sent, it is given a new header. The 
accumulated headers form a convenient record of the history of each message.

To clear messages:

 1. Use the procedure above to save text, if necessary.

 2. Click on the Clear button to remove the text from the work area. If there's an audio 
message, a dialog box will ask if you want to delete it:

 Select Yes to delete the audio message.

 Select No to preserve the audio message. You can re-send the audio message, with or 
without a new text message, to another user.

Network Installation
This section is intended for the network administrator, or the technician who will set up and 
configure VoiceNet on the Novell Network.

How VoiceNet Works

The Voyetra software installation program installs VoiceNet on individual computers. Users 
then run copies of the VoiceNet program on their individual workstations. Messages are 
stored in a directory (default name: \VOICENET) on the file server.

As a user records an audio message, the corresponding .WAV file is stored as a .TMP file in 
the Temp directory specified in WinDAT's Setup window (typically on the user's hard drive). 
When the message is sent, it is copied to the \VOICENET directory, using the file-naming 
conventions described below. The .TMP file is then deleted from the user's hard drive.

The VoiceNet programs running on each workstation notify users when they have mail 
waiting. Messages are stored on the network's file server until the recipients clear them, 
either by pressing the Clear button, or by reading a subsequent message.

How Files are Named and Stored
VoiceNet uses two types of message files    text messages and audio messages. The 
message files are assigned names and stored as follows:



The base filename is the network bindery ID number of the user (an eight-digit 
hexadecimal number).

The first letter of the extension is "T" for text messages, "A" for audio messages.

The next two letters of the extension are a unique two-digit hexadecimal number.

If one message contains both text and audio, both files are assigned the same two-digit 
hexadecimal number.    

As messages for a particular user come in, they are assigned the first unused number. As
each message is cleared, the files are deleted and that number becomes available again.

Each user's mailbox can hold a maximum of 255 (FF hex) messages. If a user's mailbox is
full, VoiceNet will not accept any further messages for that user.

To set up the network for VoiceNet:

 1. Create a directory on the file server. We suggest that you call it \VOICENET.

 2. Grant all rights except supervisory to this directory to everyone who will be using 
VoiceNet.

To set up the workstation for VoiceNet:

 1. For text messages, insure that the user's workstation:

 Has a file called VOICENET.INI in the Windows directory.

 Is logged on to the network.

 2. For audio messages, insure that the workstation also has:

 Sound hardware with digital audio capability.

 A Voyetra digital audio editor (WinDAT). It does not need to be running, but must be 
properly installed on the workstation.

 3. Edit the VOICENET.INI file to indicate the path to the VOICENET directory.

For example, if the    \VOICENET directory is on a file server drive that the user has mapped 
to drive letter M:, the user's VOICENET.INI file must contain an entry like the following:

[Options] dir=m:\voicenet\

VOICENET.INI requires only the two lines above for proper operation. Other entries that you 
may find in VOICENET.INI reflect various options and preferences chosen by the user.

Licensing

By the terms of the Software License Agreement, the copy of VoiceNet bundled with this 
soundcard may be installed and used on a single computer at any given time. If you want to
install additional copies of VoiceNet for other workstations on your network, you must either 
purchase the necessary number of sound card packages or obtain a site license from 
Voyetra Technologies. Call Voyetra at 1-800-233-9377 for site licensing information.





      SoundCheck - Sound System Diagnostics
SoundCheck, Voyetra's diagnostic program for Multimedia PC's, simplifies troubleshooting of 
sound cards, sound drivers, CD-ROM drives and MIDI devices. From a single window, you can
inspect, test and if necessary, re-configure your multimedia hardware and software.

If your multimedia system is something of a mystery to you, Sound Check can give you a 
comprehensive view of your entire setup, and help you understand how it works. But the 
real value of SoundCheck is in finding and solving problems in Multimedia PC's. It is 
especially valuable if you have to call the technical support department. Try to have this 
application running when you call.

Some of SoundCheck's controls simply provide convenient shortcuts to other parts of your 
system. For example, if you click on the MIDI configuration button, SoundCheck will launch 
whatever configuration utility came with the selected hardware driver. This means that you 
may need to refer to the instruction manuals that came with your hardware or other 
software.

ALERT: Don't wear headphones when using SoundCheck! Fixing a problem can sometimes 
result in a sudden, painful blast to the eardrums. Hold the headset a slight distance from 
your ears or place it on your desk.

To start SoundCheck: 

 1. Run the Mixer application that came with your sound card, and make sure that all the 
volume levels are set high enough to rule out problems caused by a low volume setting 
somewhere in the system.    You may need to return to the mixer a few times during testing.

 2. Make sure your output system is connected, and its amplifier and/or speakers are turned 
on and set to a reasonable volume.

 3. Double-click on the SoundCheck Icon.

Screen Display

The SoundCheck screen    is divided into three areas; one for each kind of driver and device 
you're checking: WAVE Audio, MIDI and CD Audio.

The three Drivers boxes at the left of the screen show all of the currently installed drivers for
WAV, MIDI and CD Audio devices. A message reports status of each; either "Driver OK!" or 
"Driver not working!"

You can click on any of the listed drivers to select it for testing. The currently selected driver 
is displayed in reverse video. Boxes at the right of the WAV and MIDI modules display 
suggested procedures, and the results of any tests in progress.

NOTE: In the language of Windows, the term "device " refers only to the software driver for a
given piece of hardware. Like Windows, SoundCheck cannot always detect whether the 
hardware is actually installed. As part of any testing procedure, always verify the physical 
installation of hardware.

General Controls



Create Log
Creates a log file in your Windows directory named "SOUNDCHK.ERR." You can read or print 
this ASCII text file with Windows Notepad, or any text editor you prefer. This information can 
be useful to Voyetra's tech support staff.

Refresh
Checks your system and updates SoundCheck's displays. Click this button after you make 
any changes.

NOTE: Some configuration changes only take effect after you re-start Windows, or re-boot 
your computer. Usually a message informs you of this. The Refresh button is not a substitute
for re-starting.

About
Shows the version, revision number and release date of the copy of SoundCheck in use.

Help
Opens SoundCheck's help system.

Exit
Closes the program. When you start SoundCheck again, it will reflect any changes in driver 
configuration made since the last exit.

Digital Audio - WAV Audio
Test Digital Audio Output
Plays a pre-recorded test file and displays a dialog box to confirm this. If there is no sound, 
check the most likely sources of digital audio output problems:            

Cables or headphones connected incorrectly;

Low sound card volume setting.

If these prove not to be at fault, use the Configure Digital Audio and Sound Mapper utilities 
along with your sound card's manual to locate the problem.

Test Digital Audio INPUT

Opens the Wave Input Test dialog box. This test checks the recording capability of your 
sound card:

To test digital audio input:

 1. Connect a microphone to the appropriate plug on your sound card. (Although you can use
a different input device, such as a CD-ROM drive if necessary, a microphone is best for 



simple testing.)

 2. Use your Mixer utility to select the input device you chose in the previous step, and set 
an appropriate volume level.

 3. Click the Start button to begin recording. 

 4. Speak into the microphone for a few seconds, or start playing your recording source.

 5. Click the Stop button, then click the Play button to hear the results of your test.

Configure Digital Audio
Displays a dialog box enabling you to change the configuration of the currently selected 
driver. Although you can access the same dialog box from the Windows Control Panel, this 
function allows you to change driver configuration without exiting SoundCheck. If the change
in the configuration settings is successful, the status box will indicate that the driver is "OK."

For many drivers, you will need to re-start Windows before your changes take effect. If not, 
be sure to click the Refresh button so that SoundCheck will recognize the new configuration.

Changes in a driver configuration often require corresponding changes to hardware. For 
example, you might need to move small connectors called jumpers or toggle one or more 
small switches called DIP switches on your sound card.

ALERT: Generally, you should change the configuration only if you have a problem,
and consult the hardware manufacturer's manual carefully as you work.

Sound Mapper
Opens the Microsoft Sound Mapper utility. For more information on the Microsoft Sound 
Mapper, consult your Windows manual.

MIDI Module
Test Output 
Displays the MIDI Output Test dialog box. This box lets you play a Base-level, Extended-level 
or Dual-arrangement MIDI test file. By comparing the sound of the three different types of 
MIDI files as they play, you can determine which type sounds best on your synthesizer. This 
information can help you determine which type of files to use with your synthesizer, and the 
best setup for your MIDI Mapper. For more information, consult the MIDI Mapper section in 
the appendix of your Sound Suite manual.

Unless you have selected the MIDI Mapper itself for testing, Sound Check bypasses the MIDI 
Mapper and sends MIDI data directly to the driver. This will help you to distinguish between 
incorrect MIDI Mapper settings and problems with the device driver itself.

Test Input

Opens the MIDI test Input dialog box, which allows you to test the operation of external MIDI 
hardware such as MIDI keyboards, synthesizers, or drum machines. Note that a sound card 
by itself cannot generate MIDI input for testing      a separate device, such as a synthesizer is 



required. MIDI input testing allows you to quickly determine:

Whether or not MIDI data sent from a MIDI device is reaching your computer.

On which channel it is being received.

Which MIDI device is connected to which MIDI plug.

A row of 17 LED's appears for each installed MIDI device. The first 16 correspond to the 16 
MIDI channels; the 17th LED at the far right, labeled "Misc." is for non-note MIDI messages, 
such as volume changes or SysEx data.

As you play a synthesizer or other MIDI device, one or more of the LED's flash to indicate 
when MIDI data is being received, from which device, and on which channel. 

Configure MIDI
Displays a dialog box enabling you to change the configuration of the currently selected MIDI
driver. Although you can access the same dialog box from the Windows Control Panel, this 
function allows you to change driver configuration without exiting SoundCheck. If the change
in the configuration settings is successful, the status box will indicate that the driver is "OK."

For many drivers, you will need to re-start Windows before your changes take effect. If not, 
be sure to click the Refresh button so that SoundCheck will recognize the new configuration.

ALERT: Generally, you should change the configuration only if you have a problem.
Consult the hardware manufacturer's manual carefully as you work.

MIDI Mapper
Opens the Microsoft Windows MIDI Mapper utility. You can use the MIDI Mapper to choose an 
appropriate setup for your MIDI output device, to edit an existing setup, or to create new 
ones. As a very general guide:

Base Level synths, typically FM synthesizers on sound cards, use only channels 11 
through 16 with drums mapped to channel 16;

Extended Level synths, typically Wavetable synthesizers, use channels 1 through 10 with 
drums on channel 10.

General MIDI synths, typically an external high end keyboard system, use all 16 MIDI 
channels, with drums on channel 10.

See the Appendix in the Sound Suite User's Guide for a more detailed discussion of the MIDI 
Mapper.

CD Audio
A message in the status box at the left of the CD Audio section tells you whether or not 
MSCDEX was detected. If it was, a second message informs you of the status of the Windows
MCI CD audio driver. If MSCDEX was detected and the MCI driver is opened, you can test the 
CD.

To test CD audio:



 1. Confirm that SoundCheck has detected the MSCDEX driver and that the MCI-CD driver 
has been opened. If either message shows an error, skip to the appropriate section below.

 2. Place a disk with audio tracks in the CD-ROM drive. Use a commercial CD recording      the 
kind you buy in a record store.

 3. Check your mixer settings. Be sure that the CD-ROM drive is selected and that the 
volume is turned up enough.

 4. Click the Test button to play a CD Audio track. 

To correct MSCDEX errors:

The message "MSCDEX was not detected" indicates that either:

The low-level driver for the CD-ROM is not properly loaded.

MSCDEX.EXE is not properly loaded.

The cure for either (or both) of these problems is the same.

 1. Exit SoundCheck

 2. Run the installation routine provided by the manufacturer of your CD-ROM drive.

 3. Restart your computer, and return to the CD audio test above.

To correct MCI CD errors:

 1. Click on the CD-Audio Configure button. The drivers dialog box (from the Windows Control
Panel) will open.

 2. Click on the Add button.

 3. From the list that appears, select [MCI] CD Audio, then click OK.

 4. Follow the instructions that appear on your screen. You may need your Windows 
installation disks to complete the installation.

 5. Switch back to the SoundCheck screen and click the Refresh button.

 6. Return to the CD audio test above.



 AudioStation - Component Audio Rack
AudioStation's integrated suite of programs gives you complete control of your PC's sound 
hardware. An intuitive "home stereo component" interface offers you a familiar set of 
controls for working with sound on your PC.

Main Screen Layout

AudioStation's screen is designed to resemble a component stereo system. Each component,
or module is dedicated to a particular function of your sound card. AudioStation is comprised
of the following modules:

Power Bar : Opens or closes each of the other modules, quits AudioStation and activates 
Help. When you close a module, it is removed from the screen.

Mixer Module: Controls mixer functions for AudioStation and other Windows sound 
programs.

CD Module: Plays audio tracks from your CD-ROM drive. (Requires a properly installed CD-
ROM drive.)

DAT Module: (Digital Audio Transport) Plays and records digital audio (.WAV and .VOC) files.
The Edit button launches the Wave Editor digital audio editor with the current file loaded and
ready for editing.

MIDI Module: Plays and records MIDI files on the sound card's built-in synth, and/or 
external instruments. (A MIDI interface or connector is required to connect external MIDI 
devices. Your sound card's manual should tell you how to obtain this equipment if needed.) 
The Edit button launches the MIDI Orchestrator with the current MIDI file loaded and ready 
for editing.

Playback Modules
Each of the three playback modules on AudioStation's main screen has a set of transport 
controls and a set of displays to keep you informed of the name and status of each selection 
as it's played.

Features Common to all Playback Modules

Displays

Track or Song Number: Shows the number of the current track or file in the playlist.

Min:Sec: Displays the elapsed time from the beginning of the current track or file.

Play/Pause: Lights up to indicate that the Module is in Play or Pause mode.

Buttons

Power: Closes the module.

Playlist: Opens the Module's Playlist window.



The CD Module
Displays

Playback Mode: The current mode is displayed at the far right of the Display area. The 
available playback modes are:

Playlist - Plays all the tracks in the playlist in sequence, and stops after the last track.

Shuffle - Plays the tracks in the playlist in random order until you click the stop button, 
close the CD module, or close AudioStation.

Loop - Plays all the tracks in the playlist in sequence and repeats the list from the top 
until you click the stop button, close the CD module or close AudioStation.

Single - Disregards the playlist and plays all the tracks in the order they appear on CD. 
Stops play after the last track.

Buttons

Eject: Ejects the CD from CD-ROM drives equipped with a motorized eject mechanism.

Mode: Selects the CD Module's playback mode.

Digital Audio Transport ( DAT ) Module

Displays

Current File: The name of the current digital audio file appears in the cassette tape 
graphic. An animated tape movement shows transport activity.

VU Meters: Display the digital audio playback or record levels in real time.

For stereo files, separate left and right levels are displayed. For mono files, both meters 
display identical levels.

Buttons

Edit: Launches the Wave Editor and automatically loads the current file for editing.

Record: Activates Record Standby; prepares you to record .WAV or .VOC files in the Wave 
Editor. Recording begins when you press the Play button.

The MIDI Module

Displays

Current File : The name of the current MIDI file appears just below the disk drive graphic.

MIDI Density Meters: When you play a MIDI file, these bar-graph meters display the 
relative density of the MIDI data on each of the 16 MIDI channels.

Buttons

Edit: Launches the MIDI Orchestrator with the current MIDI file loaded. 



With MIDI Orchestrator you can edit the current MIDI file, set parameters in the MIDI Module 
before recording, save a file, or record additional tracks.

Record: Activates Record Standby; prepares you to record a single track from an external 
MIDI keyboard.

Playlist Layout
The first step in using AudioStation is to construct a Playlist of the songs you'd like to hear. 
The CD, MIDI and Digital Audio modules each have a playlist window for this task. You use 
the list box on the left to browse through your files, audition them if you'd like, and with a 
few mouse clicks, arrange the desired files in the playlist on the right.

The MIDI and DAT modules are identical in appearance and operation and enable you to 
create, edit and save as many playlists as you wish. 

Since CD-ROM tracks are not computer files, the CD module operates in a slightly different 
manner from the MIDI and Digital Audio modules.

Features Common to all Playlists

Playlist box

The files in this list at the right of the playlist window are played in the order shown when 
you click on the program's Play button.

Buttons

Add: Adds the highlighted file(s) or CD track(s) to the playlist.

Add All: Adds all the files currently listed in the Name list box (or all the tracks listed in the 
CD Tracks list box) to the playlist.

Delete: Removes the highlighted file(s) or CD track(s) from the playlist.

Delete All: Removes all files or CD tracks from the playlist.

OK: Closes the Playlist window and returns to the appropriate AudioStation module with the 
playlist loaded.

Cancel: Closes the Playlist window and returns to the appropriate AudioStation module 
without updating the playlist.

MIDI and DAT Playlists only

Files list box

This list box operates just like any windows "File open" dialog box. Use it to navigate among 
drives, directories and files in your system and to select the files you wish to place in the 
playlist.

Buttons

Audition: Plays the file that is currently highlighted in the Files list box.



Auto: When Auto is enabled, files automatically play when highlighted in the Files list box.

Load: Activates a dialog box from which you can load an existing playlist file.

Save: Activates a dialog box from which you can save the playlist as a file.

CD Playlist only:

CD Tracks List box

Shows you the contents of the currently loaded CD-ROM disc, the number of tracks on the 
disc and the total length of the tracks in minutes:seconds. Initially, there are no titles for 
tracks; you enter the names of the tracks yourself. You only need to do this once. Then, each
time you load that CD, AudioStation recognizes the disk and retrieves its playlist.

Buttons

Name CD: Activates a dialog box from which you can enter a title for the CD.

Name track: Activates a dialog box for naming each track on the CD.

Mixer Module

The Mixer Module provides an easy-to-use interface to control your sound card's mixer 
functions. You can use the Mixer module with most Windows sound programs    it's not 
limited to AudioStation.

NOTE: Because of wide differences among sound cards, each has its own mixer 
configuration. The mixer for your sound card is set automatically when you install the card's 
software.

Space does not permit documenting all the features of every sound card made, so we'll show
you how a typical one works (a Sound Blaster) and include some additional notes about 
others.

Just keep in mind that the AudioStation's mixer duplicates the functions of the Windows 
mixer that came with your sound card. By consulting your sound card's documentation, and 
experimenting with the mixer, you'll be using it like a pro in no time.

CAUTION: Some sound cards can generate a strong audio signal loud enough to 
cause discomfort or hearing problems. If you use headphones, take them off 
before you try the Mixer for the first time.

Most functions are controlled by sliders. Sliders that appear in pairs provide individual 
control over the left and right stereo channels.

Mixer Controls

Power: Closes the Mixer Module.

Lock: Locks all pairs of stereo sliders together, allowing you to control both the left and right
levels simultaneously. 



To set a pair of locked sliders to equal levels, drag both sliders all the way to the top or 
bottom.

Mode: Opens a dialog box that gives you access to other mixer features.

Default: On most mixers this button is replaced by a "Default" button, which resets all of 
the Mixer Module's controls to their original default settings.

MIDI: Controls the playback level of the sound card's on-board synthesizer.

 (FM, Synth): On many mixers the MIDI slider is labeled "FM" or "Synth."

Voc: Controls the playback level of the sound card's digital audio hardware.

 (Wave, Wav): On most mixers the digital audio slider is labeled "Wave," or "Wav." It does 
not control wavetable synthesis hardware.

Line: Controls the playback level of the sound card's Line-level audio output.

CD: Controls the playback level of the CD-ROM drive's audio output. It is assumed that the 
CD-ROM drive is connected to the multi-pin header on the sound card.

 (Line/CD, CD/Line, CD/Aux): A CD-ROM audio player is actually a Line-level device, so 
some mixers use a single slider, labeled "Line/CD," "CD/Line" or "CD/Aux" to control both.

Mic: Controls the sound card's microphone input level.

Spk: Controls the playback or record level of your PC's internal speaker signal. (This does 
not work on all systems.)

Gain: A pair of numericals that adjust the output signal of the sound card, allowing you to 
tailor it to different output systems; i.e., headphones, self-contained speakers, speakers 
connected to an amplifier, etc. You can adjust the output level of the left or right channel by 
a factor or 2, 4, or 8.

As a general rule, you should leave these off or at the minimum settings and adjust them 
only if you are having difficulty in recording or playback.

 (Record Gain): On most systems, gain controls affect only the overall record level of the 
selected record sources, allowing you to use a wider variety of microphones for recording. 
Gain controls appear as sliders on some systems, as buttons on others. The button 
configuration usually provides a 20 dB boost. 

Tone: Two pairs of stereo sliders, one for bass, one for treble. 

Some mixers use a graphic display to show the relative settings of bass (left display) and 
treble (right display). To adjust the levels, click and hold the buttons above or below each 
display.

Many sound cards don't support tone controls. You can adjust the amplifier's or speakers' 
tone controls instead.

Master: Controls the sound card's overall playback level. 



Source: Allows you to select individual sound sources for playback.

 (Record Source buttons): Many mixers have similar buttons assembled in a group or 
along the bottom edge of the mixer. These allow you to select one or more audio sources 
(CD, WAV, FM, Spk, Line or Mic) for digital audio recording. Click on individual buttons to 
toggle each source On (red) or Off (green).

After you've selected a combination of sound sources, you can use the sliders to adjust their 
volumes individually. If Mix is offered as a record source, you can record a mix of several (or 
all) of the sound card's sound sources. Check your sound card's documentation for more 
complete descriptions of what these buttons do.

Other Mixer controls you may encounter:

Thru, Monitor: Lets you route the selected Record Source to the sound card's output so 
that you can preview and/or monitor the signal while recording.    It's also handy for "cueing-
up" a CD or tape prior to recording.

On some systems, this control serves another purpose as well. When the Line Record Source
button is enabled, it controls the playback level of the sound card's line-level input. 

Record: Volume sliders to control the record level of the selected Record Source(s).

M: Mute buttons. When active, these buttons appear dark gray and they silence the output 
for that particular sound source.

D16, WS, Z.wav: Some sound cards include both an FM and a Wavetable synthesizer, but 
permit the use of only one synth at a time. Others allow simultaneous use of both. These 
sliders control the Wavetable synth on those sound cards.

Tutorial
The Power Bar

The Power Bar lets you open or close the different modules, re-arrange the stack of modules,
access on-line help and quit AudioStation.

To open, close or arrange modules:

 1. Click on the appropriate icon button on the Power Bar. If the module is open, it will close 
and disappear from the stack. If a module is closed, it will open and appear at the bottom of 
the stack. 

 2. Open and close modules as desired to re-arrange the stack.

To quit AudioStation:

From the Power Bar, click on the Power button. The current arrangement of modules will be 
restored the next time you open AudioStation.

To access AudioStation's on-line Help:

Click on the Help (?) button in the Power Bar.



Making a Playlist

We suggest that you start this tutorial with the MIDI or DAT playlist before moving on to CD-
ROM.

In the MIDI and DAT modules, you must always make a playlist, even if it contains only a 
single file. You can edit and save as many playlists as you wish. 

To create a playlist:

 1. Click on the Playlist button at the lower left corner of either the MIDI or DAT module. A 
Playlist window will appear.

 2. Navigate to the drive and directory where the desired files are located.

 3. In the Type list box at the lower left, choose the desired file extension. The Files box will 
now display all files with the selected extension.

To audition a file, click on its filename to highlight it, then click on the Audition button.

To audition files automatically, activate the Auto button. Each file will begin playing the 
moment you highlight it.

To stop audition playback, de-activate the Auto button if necessary, then click on any 
filename.

 4. In the leftmost box, double-click on the desired file. The file will be added to the playlist in
the box at the right.

 5. Repeat the steps above to complete your playlist.

 6. Click the OK button to return to the AudioStation module.

To hear your playlist:

 1. Click on the module's Play button. The file or files in your playlist will begin playing, in 
order.
 2. Use your Mixer Module to adjust the playback level if you wish.

 3. To hear a different selection without waiting, use the Previous selection and Next 
selection buttons to jump to the desired selection.

 4. To halt playback before the playlist is finished, click on the Stop button.

To save a playlist (MIDI and DAT only):

 1. Click on the Save button in the playlist window.

 2. Navigate to the directory where you'd like to keep your playlists.

 3. Type a filename in the Files box. By default, DAT playlists are saved with a *.VSL file 
extension; MIDI playlists are saved with a *.VML extension.

To load an existing playlist:



 1. Click on the Playlist button in the desired module to open its playlist window.

 2.    (MIDI and DAT only) Click on the Load button.

 3. Navigate to the drive and directory and double-click on the desired filename.

Editing playlists

It's easy to rearrange the order of playlists if you keep this simple rule in mind: At least one 
line is always highlighted in the playlist box and items (or groups of items) are always 
inserted above the highlight.

To insert items in a playlist:

 1. In the Playlist box at right, highlight the line just below where you want to insert an item.

If you want to add an item to the bottom of the playlist, highlight the blank line below the 
last item in the list.

 2. In the box on the left, double-click on the desired filename or track, or click on the Add 
button.

To insert multiple items:

 1. Select an insertion point in the playlist, as described above.

 2. In the box at left, select the items you wish to add:

To select a group of consecutive file names, click and drag your mouse up or down over 
the desired file names.

To select a group of non-consecutive file names, hold down the [Ctrl] key as you click on 
individual file names.
 3. Click on the Add button.

To insert all the matching files in the current directory, click on the Add All button.

To delete items:

 1. In the playlist box at right, select the item you wish to remove.

 2. Click on the Delete button.

To remove all the files from the playlist, click on the Delete All button.

NOTE: Delete operations can only remove files from a playlist. There is no danger of erasing 
files from your hard disk.

The CD Playlist

For the most part, the CD Playlist window operates in the same way as the DAT and MIDI 
Playlist windows. You select tracks from the CD Tracks list box and arrange them in the 
Playlist box, just as you do with digital audio and MIDI files.

However, because the CD audio tracks are not computer files, there are several differences 



in the CD Playlist:

When you first load a new CD, the CD Tracks list box on the left side of Playlist window 
displays Untitled 1, Untitled 2, and so on, for each track on the disk. You can enter the titles 
of the tracks (or any text you wish), and assign a name to the CD itself using the Name Track
and Name CD buttons.

Above each list box (CD Tracks and Playlist) a display shows the Total Tracks and the Total
Time for each list.

The Add All and Delete All buttons act on all the tracks on the CD.

The Name CD and Name Track buttons replace the Audition and Auto buttons.

You can play CD tracks without creating a playlist.

There are no Load and Save buttons. Once you have created a playlist, the CD Module 
will automatically remember the Name, Track Names, and the playlist order for that 
particular disk. A given disk can have only one playlist at a time but you can change its 
playlist as often as you wish.

To name a CD:

 1. From the CD Playlist window, click on the Name CD button.

 2. Enter a title for the disk in the dialog box and click OK.

To name CD tracks:

 1. Click on the desired track in the CD Tracks window.

 2. Click on the Name Track button.

 3. Enter the desired name for the track in the dialog box.

 4. Press the [Enter] key, click on the Next button or click on the Up or Down arrows. 
Continue entering track names until you've completed the list, then click OK.

To play CD tracks without a playlist:

 1. Insert an audio CD in your CD-ROM drive.

 2. Click on the CD Module's Mode button to select any mode except Playlist: Shuffle, Loop or
Single.

 3. If you selected Loop or Single, use the Previous Track or Next track buttons to select the 
desired track.

 4. Click on the Play button.

 5. Use the Next Track or Previous Track buttons as desired to select different tracks.

Recording in AudioStation
You can make Digital Audio or MIDI recordings quickly and directly from the appropriate 



AudioStation playback module.

ALERT: Each time you start recording from AudioStation you create a new file, 
overwriting the currently loaded file.

When you use AudioStation to control recording, the underlying application, the Wave Editor 
or MIDI Orchestrator, actually does the work. This means that whatever settings are in effect
for those applications will be used when you record. 

When recording MIDI, all the incoming MIDI data is merged and recorded onto a single 
track on the first channel that has an assignment in the Windows MIDI mapper.

During Digital Audio recording, the VU Meters will display the record level. If the red 
LED's light up most of the time, you may need to use the Mixer Module to reduce the record 
levels.

To set up or confirm recording parameters, or to save files in the Wave Editor or MIDI 
Orchestrator, click on the Edit button in the appropriate playback module.

To record a MIDI or digital audio file:

 1. If necessary, use the Mixer Module to select an input source such as Mic or CD and set its 
record level.

 2. If you want to record from your sound card's CD-ROM drive, or from an external source 
such as a tape deck, cue up the material as needed.

 3. Click on the Playback module's Record button. The red LED will blink, indicating that the 
module is in Record Standby mode.

 4. Click on the Play button to begin recording. Speak into the microphone or start playing 
the material you prepared earlier.

 5. To pause temporarily during recording, click on the Pause button. Click the pause button 
again to resume recording at the point where you left off. (You can use the Spacebar instead 
of the Pause button.)

ALERT: Use only the Pause button or the Spacebar to resume recording. If you 
click the Record button, you'll erase the existing recording and start a new one.

 6. When you're finished recording, click on the Stop button.

 7. Click on the Play button to hear what you've just recorded. You can follow the above 
steps to re-record if you wish. The new material will replace the currently recorded material.

To edit files from a module:

 1. Load a Playlist containing the desired file into its module or create a new playlist.

 2. Return to the module and use the Next File or Previous File buttons to access the desired 
file.

 3. Click on the Edit button to activate the Wave Editor or the MIDI Orchestrator.

 4. Edit and save the file as desired.



AudioStation and Voice Recognition Software

Because there is a keystroke equivalent for each of its commands, you can control 
AudioStation with many Windows-based voice recognition programs. Typically, voice 
recognition software allows you to associate one or more keystrokes (called "key macros") 
with a given voice command. We've included a chart that lists the keystroke equivalent for 
every AudioStation command, along with a recommended voice command for each.

Using the chart below as a guide, create a voice command/keystroke template and "train" 
your voice recognition program to recognize each spoken command. Refer to your voice 
recognition software for more information.





 MIDI Orchestrator - MIDI Mixer/Recorder
The MIDI Orchestrator's channel-based mixing console makes it easy to play, record, and 
optimize MIDI files. You can easily select instrument sounds, balance channel volumes, 
control tempo, transpose tracks, add new tracks to existing MIDI files or create multi-track 
MIDI compositions from scratch.

Screen Layout

Controls and Displays

Transport Controls

Transport controls are located at the top of the screen, directly beneath the Menu bar. MIDI 
Orchestrator uses familiar Transport Controls that duplicate those found on a VCR or tape 
recorder.

Rewind (Double Backward Arrow) : Clicking and holding the Rewind button moves the 
pointer backward through the song in small increments. To rewind more rapidly, Shift -click 
and hold the Rewind button.

To return to the beginning of the song, double-click the Rewind button.

Stop(Square Button) : Clicking the Stop button halts playback or recording and 
automatically rewinds to the position at which playback or recording started. 

Play (Single Forward Arrow) : Clicking the Play button initiates playback of the song, 
starting from the current position.. 

Record (Red Light): Clicking the Record button puts MIDI Orchestrator into Standby mode, 
ready to record MIDI data onto a record-enabled track. Click the Play button to begin actual 
recording.

Pause (Double Bar) : Clicking the Pause button will temporarily halt playback or recording.
Once paused, clicking again on the Pause button will resume playback or recording without 
rewinding.

Fast Forward (Double Forward Arrow) : Clicking and holding the Fast Forward button 
moves the pointer forward through the song in small increments. To advance more rapidly, 
Shift-click and hold the Fast Forward button.

To advance to the end of the song, double-click the Fast Forward button.

Global Controls

 The Global Controls are located directly to the right of the Transport controls.

Song Position: Displays the location in the song file where playback will begin. You can 
drag the pointer with the mouse to any location in the song.

Tempo: Displays and allows you to set the current song's tempo in Beats Per Minute.

+/-: (Tempo Offset) Allows you to modify a song's tempo overall by a fixed amount, in Beats 
Per Minute.



Channel Modules

The MIDI Orchestrator contains 16 separate modules, which are shown in the center of the 
screen. Each module is a collection of displays and controls which operate on a single MIDI 
channel. From the top down, these are:

Info: Each of the numbered buttons opens a dialog box that provides a summary of the 
parameters and a set of controls for its respective channel.

MIDI Density Meters: Indicate which channels are active and, for those that are, 
graphically indicates the relative number of notes being played.

Solo: Mutes all other channel modules, making it easier to isolate one or more channels. To 
"solo" multiple channel modules, [Ctrl]-click on the desired Solo buttons. 

Mute: Silences playback of the selected channel.

Rec: Activates the selected channel for recording. All incoming MIDI data is routed to that 
channel.

Patch : Numerical to select the patch (instrument sound) to be used by a channel module. If
no patch is selected (" -"), the synthesizer plays the most recently assigned patch or its 
default patch.

Volume : Adjusts the MIDI volume for the selected channel.

Tk Name: Displays the first few characters of the name of the first track on each channel. 
As you move your mouse pointer over the window, it expands to display the full track name.

Status Area

Status: Displays the MIDI Orchestrator's current status: Stopped, Playing, Paused, Standby 
or Recording.

Current Time: Displays the elapsed time from the beginning of the song in 
Minutes:Seconds.

Total Time: Displays the total length of the song in Minutes:Seconds, taking the tempo 
setting into account.

Current Bar: Displays the current song position in Bars:Beats.

Total Bars: Displays the total length of the song in Bars:Beats.

Menus

Located at the top of the screen, the Menu Bar contains the following menu listings:

File Menu

New: Opens a new, empty file.

Open: Presents a dialog box to select the file you wish to load. 



Save: Saves the currently-loaded file to disk. If the file already has a name, it will be saved 
under that name. Otherwise, the Save As... dialog box will appear.

Save As...: Presents a dialog box for naming and saving the current file to disk. 

Exit: Exits MIDI Orchestrator.

1/2/3/4: (File List) Lists the paths of the four most recently opened files. To open a listed file,
click once on its entry.

Options Menu

Metronome: When Metronome is enabled, the MIDI Orchestrator will produce a short tone 
from the PC speaker for each beat. You can use the metronome as a timing reference while 
recording. 

Save Settings on Exit: When the Save Settings on Exit option is enabled, the current 
Metronome setting is saved whenever you quit the MIDI Orchestrator. 

MIDI Input Device: Allows you to select a MIDI input device for recording. The Orchestrator
always uses the Windows MIDI Mapper as its MIDI output device. 

Help Menu

Contents: Activates the MIDI Orchestrator's on-line Help system.

About: Presents the MIDI Orchestrator's "About..." box, containing the program's revision 
number and creation date.

Sample Files

This edition of MIDI Orchestrator includes samples from the large library of MusiClips MIDI 
Song Files available from Voyetra. All MusiClips MIDI files are mapped with General MIDI 
patch assignments for both Base-Level and Extended type synthesizers, in compliance with 
Microsoft's Multimedia Authoring Guidelines.

Tutorial
Loading and Playing a MIDI Song File

The MIDI Orchestrator uses the Windows Control Panel's MIDI Mapper as its output device.

You'll probably notice that the MIDI Density Meters for some of the channels are grayed out. 
This is normal, indicating that there is no port assignment for that channel in the Windows 
MIDI Mapper and the channel is disabled.

To load and play a MIDI file:

 1. Choose Open from the Files menu and navigate to the drive and directory for your MIDI 
files. 

 2. Double-click on the filename of the desired song.

As the song file loads into MIDI Orchestrator, the sliders adjust to the correct volume for 



each channel, and the status indicators display the length of the song.

 3. Click on the Play button to play the song. 

As the song plays, the Status indicator reads "Playing", the MIDI Density Meters indicate the 
activity on each channel and the Song Position indicator advances from left to right.

Recording a Song

In order to record with MIDI Orchestrator, you need a MIDI interface or connector and a MIDI 
keyboard. Make sure the MIDI Out of your keyboard is connected to the soundcard's MIDI In. 
Refer to the soundcard's hardware documentation if you need more information.

During recording, all the incoming MIDI data, regardless of its MIDI channel assignment, is 
merged and placed into one channel.

To prepare for recording:

 1. From the Options menu, enable the Metronome if you wish. 

 2. Set the desired tempo using the Tempo control. 

 3. Click on the Record Enable button to select the channel module into which you wish to 
record. A red light on the button indicates which module is enabled.

In general, you should record only on channels whose MIDI density meters are visible.

If you're using a base-level synth, use channel 13, 14 or 15 for melodic instruments.

If you're using an extended-level or General MIDI synth, use channels 1 through 9 for 
melodic instruments.

If you're not sure whether your synth is a base-level or extended type, or what these 
terms mean, see your soundcard's documentation.

Use lower-numbered channels to record the more important parts.

 4. Use the patch selector numerical to choose a patch number for monitoring as you record.
If you are not familiar with patches, see the next section, "Editing a Song." For now, you can 
set the patch to 1, which usually creates the sound of a piano.

 5. Turn down the volume on your MIDI keyboard and play a few notes. You should now hear 
the selected patch on your sound card's synthesizer. If you do, you're ready to record.

To record a melodic track:

 1. Click on the Record button in the Transport Controls area.

The blinking red light indicates that Orchestrator is in Record Standby mode.

 2. Click the Play button to start recording

The red light will stop blinking and remain lit, indicating that Orchestrator is recording. If you
enabled the metronome, you should now hear the PC speaker counting out the tempo.



 3. Play your part on the MIDI keyboard.

 4. Click on the Stop button to stop recording.

 5. Click the Play button to hear what you've just recorded. You can repeat the steps above 
to re-record the track if you wish. The new data will replace the entire track.

To record a drum part:

 1. Click the correct Record Enable button for the Drum channel on your synth:

If you're using a base-level synth, use channel 16.

If you're using an extended-level or General MIDI synth, use channel 10.

If you're using a non-General MIDI external device, refer to its documentation to 
determine which channel it uses for drums.

 2. Start recording, as described above.

Each key on your MIDI keyboard will now act as a different drum instrument. The "General 
MIDI Drum Note Assignments" listing below will give you an idea of which key triggers which 
drum sound. (Not all devices will use the drums in this listing. Check the documentation for 
your MIDI device if necessary.)

 3. Record your drum part.

Once you've recorded your first part, you can record, or overdub, additional parts on the 
other channels as you would in a professional recording studio. You can listen to parts that 
you've already recorded as you record new ones.

To overdub additional parts:

 1. Choose another channel and click its Record Enable button.

 2. Use that channel module's Patch Selector to choose an instrument sound for your new 
part. 

 3. Use the Mute and/or Solo buttons to choose which of the existing tracks you want to hear
as you play the new part.

 4. Follow the same procedure as you did when recording the first track.

To save a file:

 1. Choose Save from the File menu.

 2. Select a file format; .ORC or .MID. These formats are detailed in the "Choosing a File 
Format" below.)

 3. Type a new file name in the dialog box, and Choose OK.

Once you've recorded your new song, or added new tracks to an existing song, you can 
customize it with the MIDI Orchestrator editing controls described below.



Editing a Song

Global parameters:

To move around in the song:

 1. Drag the Song Position Pointer left or right with the mouse to move to any position within 
the song.

 2. Check the Current Position window (in the Status area at the bottom of the screen) to 
verify your song position. Playback will begin at that point.

To set or change a song's tempo:

 1. Click on the Tempo numerical and drag up or down to set the initial tempo for the song.

Some MIDI files contain a tempo map  a series of additional messages to change the tempo 
at various points throughout the song. Each tempo setting remains in effect until a new one 
is encountered or until the end of the song.

To adjust all the tempos in a song:

 1. Click and drag the mouse up or down on the Tempo Offset numerical.

The Tempo Offset control changes all the values in the tempo map, including the initial one, 
by the amount you select. 

Channel parameters

To adjust the channel volumes:

Drag the sliders for each active channel up or down as desired. (Some MIDI devices do no 
respond to MIDI Volume and the sliders will have no effect on these devices.)

To turn individual channels on or off:

 1. To silence a single channel, activate its Mute button. You may mute as many channels as 
you wish.

 2. To hear a single channel, activate its Solo button. To "solo" several channels, hold down 
the [Ctrl] key as you click on each desired Solo button.

Patch Assignments

You can assign any of 128 patches (instrument sounds) to each channel and change the 
patches at any time    even as a song is playing.

To assign a patch with the Patch Selector:

Use the Patch Selector numerical (just above the volume slider) to assign a patch number to 
each active channel. Use the "General MIDI Patch Map" at the end of this file as a guide in 
choosing instruments. (Some devices don't adhere to this listing. Check the documentation 
for your MIDI device if necessary.)

If the MIDI Orchestrator is playing, you'll hear the changes as you call up different patches.



A hyphen in any Patch Selector indicates that no patch is assigned to that channel. In this 
situation, a channel will use the instrument's default patch or the last patch that was called 
up on that channel.

One channel (typically channel 10 or 16, depending on the type of synth) is set aside for 
drum sounds. You cannot use the MIDI Orchestrator to change drum sounds.

Channel Info Dialog Box

Each Channel Module has its own Channel Info dialog box. To open a Channel Info Dialog 
Box, click on the numbered button at the top its module.

The dialog box gives you a summary of all the settings for that channel and allows you to 
adjust them.

Tracks on Channel: Lists the names assigned to all the tracks on the channel and allows 
you to select a track to name, re-name or transpose.

Note: When you use MIDI Orchestrator to record new data in an existing MIDI file, the new 
material creates a single track on the selected channel, and replaces all pre-existing data on
all tracks assigned to that channel.

Selected Track: Displays the currently-selected track.

Transpose: Allows you to transpose the selected track by octaves and/or semi-tones.

Patch: Displays the MIDI patch number and the name assigned to the current patch 
(sound); allows you to select a patch for that channel.

To assign a patch from the Channel Info dialog box:

 1. Click on the desired patch name in the Patch list box. If you do this as a song is playing, 
you'll hear the effect of the patch change.

 2. Click OK. The new patch number will appear in the channel module's Patch Selector 
control on the main screen. 

To name or re-name a track:

 1. From the Tracks on Channel list box, click on the track you wish to re-name. If it's a newly-
recorded track, it will be named "New."

 2. Type a new name in the Selected Track edit box and Click OK.

To make it easier to identify what's on each channel, use the procedure above to edit the 
name of the first track. The first few characters will appear in the channel module's Tk Name
area in the main screen. Whenever the mouse cursor touches the Tk Name area, the window
expands to display the full track name.

To transpose a track:

 1. Click on the Channel Info button of the channel module containing the track you want to 
transpose. 



 2. If there is more than one track listed, click on the name of the track you wish to 
transpose in the Tracks on Channel list box. That track name will now appear in the Selected 
Track box.

 3. Use the Octave numerical to transpose the pitch of the selected track up or down by 
octaves.

 4. Use the Semi numerical in the same manner to transpose by semi-tones.

Choosing a File Format (.ORC or .MID)

MIDI Orchestrator allows you to open and save song files in two Formats:

Voyetra's proprietary Orchestrator (.ORC) format, or in standard MIDI (.MID) format.

.ORC - If the file is just for your own use, or if you plan to share the file with another 
application that supports .ORC files such as Voyetra's MIDI Orchestrator Plus, save your song
in Voyetra's proprietary .ORC format. This format preserves all of the file's settings.

.MID - For compatibility with most other PC MIDI applications, use the standard .MID format. 
When you save a file in this format, settings for mute/solo, tempo/tempo offset settings and 
transpose are combined and the resulting new values are saved.

ALERT: Be sure to check all of your Mute and Solo settings before you save a file in .MID 
format. Any tracks that you have de-activated with the Solo or Mute buttons will be deleted 
during the save operation.

When in doubt, use the .ORC format. You can always re-open a file and save it in .MID format
later.

General MIDI Patch Map

Piano
1Acoustic Grand Piano
2Bright Acoustic Piano
3Electric Grand Piano
4Honky-tonk Piano
5Rhodes Piano
6Chorused Piano
7Harpsichord
8Clavinet Chromatic

Percussion 
9Celesta
10Glockenspiel
11Music box
12Vibraphone
13Marimba
14Xylophone
15Tubular Bells
16Dulcimer 

Organ    
17Hammond Organ
18Percussive Organ



19Rock Organ
20Church Organ
21Reed Organ
22Accordion
23Harmonica
24Tango Accordion

Guitar 
25Acoustic Guitar (nylon)
26Acoustic Guitar (steel)
27Electric Guitar (jazz)
28Electric Guitar (clean)
29Electric Guitar (muted)
30Overdriven Guitar
31Distortion Guitar
32Guitar Harmonics

Bass 
33Acoustic Bass
34Electric Bass (finger)
35Electric Bass (pick)
36Fretless Bass
37Slap Bass 1
38Slap Bass 2
39Synth Bass 1
40Synth Bass 2

Strings
41Violin
42Viola
43Cello
44Contrabass
45Tremolo Strings
46Pizzicato Strings
47Orchestral Harp
48Timpani

Ensemble 
49String Ensemble 1
50String Ensemble 2
51SynthStrings 1
52SynthStrings 2
53Choir Aahs
54Voice Oohs
55Synth voice
56Orchestra Hit

Brass
57Trumpet
58Trombone
59Tuba
60Muted Trumpet
61French Horn
62Brass Section
63Synth Brass 1



64Synth Brass 2

Reed 
65Soprano Sax
66Alto Sax
67Tenor Sax
68Baritone Sax
69Oboe
70English Horn
71Bassoon
72Clarinet

Pipe
73Piccolo
74Flute
75Recorder
76Pan Flute
77Bottle Blow
78Shakuhachi
79Whistle
80Ocarina

Synth Lead 
81Lead 1 (square)
82Lead 2 (sawtooth)
83Lead 3 (calliope lead)
84Lead 4 (chiff lead)
85Lead 5 (charang)
86Lead 6 (voice)
87Lead 7 (fifths)
88Lead 8 (bass + lead)

Synth Pad
89Pad 1 (new age)
90Pad 2 (warm)
91Pad 3 (polysynth)
92Pad 4 (choir)
93Pad 5 (bowed)
94Pad 6 (metallic)
95Pad 7 (halo)
96Pad 8 (sweep)

Synth Effects 
97FX 1 (rain)
98FX 2 (soundtrack)
99FX 3 (crystal)
100FX 4 (atmosphere)
101FX 5 (brightness)
102FX 6 (goblins)
103FX 7 (echoes)
104FX 8 (sci-fi)

Ethnic
105Sitar
106Banjo



107Shamisen
108Koto
109Kalimba
110Bagpipe
111Fiddle
112Shanai

Percussive
113Tinkle Bell
114Agogo
115Steel Drums
116Woodblock
117Taiko Drum
118Melodic Tom
119Synth Drum
120Reverse Cymbal

Sound Effects 
121Guitar Fret Noise
122Breath Noise
123Seashore
124Bird Tweet
125Telephone
126Helicopter
127Applause
128Gunshot

General MIDI Drum Note Map

35Acoustic Bass Drum
36Bass Drum 1
37Side Stick
38Acoustic Snare
39Hand Clap
40Electric Snare
41Low Floor Tom
42Closed Hi-Hat
43Hi Floor Tom
44Pedal Hi-Hat
45Low Tom
46Open Hi Hat

47Low-Mid Tom
48High-Mid Tom
49Crash Cymbal 1
50High Tom
51Ride Cymbal 1
52Chinese Cymbal
53Ride Bell
54Tambourine
55Splash Cymbal
56Cowbell
57Crash Cymbal 2
58Vibraslap



59Ride Cymbal 2
60High Bongo
61Low Bongo
62Mute High Conga
63Open High Conga
64Low Conga
65High Timbale
66Low Timbale
67High Agogo
68Low Agogo
69Cabasa
70Maracas

71Short Whistle
72Long Whistle
73Short Guiro
74Long Guiro
75Claves
76High Wood Block
77Low Wood Block
78Mute Cuica
79Open Cuica
80Mute Triangle
81Open Triangle



JukeBox
The Voyetra Jukebox lets you assemble sound events into playlists then play them in the 
order you've arranged. Playlists can include .WAV files, MIDI files, or CD audio tracks.

Playlist Controls and Displays

Edit Buttons

Provide quick access to the four most frequently used Edit commands: Cut, Copy, Paste, and 
Undo. (See Edit menu section below.)

Transport Controls

Jukebox uses Transport Controls common to many Voyetra Window applications.    If you 
aren't familiar with their operation, see the included "Common Controls" documentation file.

Title Boxes

Playlist: Displays the title of the current playlist.

CD Title: Displays the title of the CD in use by the current playlist.

Add...: Opens the Sound Event Manager window. (See next section.)

Playlist

Lists the individual sound events in the playlist.

Status Area

Status: Displays the current status of the Playlist (Playing CD, Playing WAV, Stopped, 
Paused, etc.). 

WAV, MID, CD: Displays how many events of each type are in the playlist.

Playlist Menus 

File

New: Creates a new, empty playlist.

Open: Presents a dialog box to select the playlist file you want to load.

Save: Saves the current playlist file to disk, overwriting the existing version.

Save As...: Presents a dialog box for naming and saving the current playlist file to disk.

Exit: Halts playback and terminates the Windows Jukebox program.

About: Displays information about this version of Windows Jukebox.



File List (1 2 3 4): Allows single-click opening of the four most recently-opened playlist 
files.

Edit

You can execute the Cut, Copy and Paste and Undo commands from the Edit menu or with a 
click of the Edit buttons just below the menu bar.

Undo: Reverses the effect of the most recent Edit operation.

Cut: Removes selected sound events from the playlist and puts them in the clipboard.

Copy: Puts the selected sound events in the clipboard without altering the playlist.

Paste: Places sound events from clipboard into a playlist. Events are inserted above the first
selected event in the playlist. If no event is selected, events are appended to the bottom of 
the list.

Delete All...: Deletes all events of the specified type (WAV, MID, or CD) from the current 
playlist.

Deselect All: Deselects (cancels) all event selections in the playlist.

Options

Auto Audition: When enabled, lets you play each file by clicking on its file name in the 
Sound Event Manager dialog boxes.

Loop: When enabled, repeats the playlist indefinitely, until you stop playback.

Sound Event Manager Controls and Displays

The Sound Event Manager is a customized version of a Windows "file open" dialog box. Use 
this window to locate, audition and select sound events to add to your playlist. To open the 
Sound Event Manager window, click on the Add... button in the Playlist window.

Audition Transport

These buttons allow you to start and stop playback of the currently selected file or track. See
the Getting started Section for further details on transport controls.

View Buttons

WAV, MID : Displays the available drives and directories on the left and files with a .WAV 
or .MID extension on the right.

ALL: Displays all files in the current directory, regardless of their extension.

The two boxes at the bottom of the window, labeled "Directory" and "Filename," display the 
path and the name of the currently highlighted file.

CD: Click on the CD button to view a list of the tracks on the disk currently in the CD-ROM 
drive.

Notice that the Directory and File boxes at the bottom have changed. They provide a place 



to display the Title of the CD and the name of the currently selected track. Initially, these 
boxes are blank, as shown above. The procedure for entering disk titles and track names is 
described in the section called "Working With CD Tracks."

Tutorial

Playing the Sample Playlist

The first step in using Jukebox is to construct a Playlist of the songs you'd like to hear. You 
use the Sound Event manager to browse through your files, audition them if you'd like and 
arrange the desired files in the Playlist window. When you click on the Play button, Jukebox 
plays the events in the list in the order you've placed them.

You can create and edit as many playlists as you wish, and save each as a file with a .JUK 
extension. To get you started, we've included a sample playlist file called SAMPLE.JUK which 
plays several of the included WAV and MIDI files. This sample playlist does not include any 
CD-ROM audio tracks.

To play the sample playlist:

1. Choose Open from the File menu, navigate to the directory where Jukebox is located and 
open the file called SAMPLE.JUK.

2. Click the Play button. Jukebox will play the events in the order shown.

3. To play a list repeatedly, choose Loop in the Options menu.

4. To jump backward or forward through the playlist, click the Previous and Next buttons. (It's
okay to do this during playback.)

5. To momentarily pause playback, click the Pause button. Click on the Pause button again to
resume.

6. You can use other Windows programs while Jukebox plays, if you wish.

7. Jukebox stops when it reaches the end of the playlist. To halt playback before the end, 
click on the Stop button.

To start playback from within a playlist:

1. Click on any event in the sample playlist to select it.

2. Click the Play button. Jukebox will begin playback with the first selected event.

Creating Playlists

To create a playlist:

1. From the File menu, choose New.

2. If you plan to include CD tracks in your playlist, load the audio CD into the CD-ROM drive.

NOTE: To be sure that the disc contains audio tracks, use a commercial recording    the kind 
you buy in a record storenot a software disc.



3. Click on the Add button. The Sound Event Manager dialog box will appear.

4. Click on one of the four View buttons to choose the type of sound event you wish to add 
to the list. A dialog box will display files with .MID or .WAV extension or a list of the tracks on 
the disk in your CD-ROM drive, depending on your choice. If you select ALL, every file in the 
current directory is displayed.

5. If you chose WAV or MID, navigate to the desired drive and directory.

6. To audition a file or CD track, highlight it and click on the Event Manager's Play button. To 
hear a sample of each file automatically as you highlight it, choose Auto Audition from the 
Options menu.

7. Select the files or tracks to add to the playlist:

· To select a single event, click on it with the mouse.

· To select a group of consecutive events, click and drag the mouse across the desired files 
or tracks.

· To select non-consecutive items, hold down the [Ctrl] key as you click on individual items.

· To de-select any event click on it again while holding down the [Ctrl] key.

8. In the Playlist Window, click on the Copy button, then click the paste button. The events 
will be added to the end of the playlist.

9. To insert an event within a playlist, select an item in the playlist before you click the Paste 
button. New items are always inserted above the first selected item in the playlist.

Shortcut: To quickly add a single event to the Playlist, just double-click on the event.

10. Continue adding events to build your list. You can mix MIDI files, .WAV files or CD tracks 
in any order you wish in the same playlist.

11. Enter a title for your playlist in the Playlist box if you wish. You cannot edit the contents 
of the CD title box; this information is added automatically by the Sound Event Manager.

12. Select Save from the File menu to save your list with the extension .JUK.

13. Press the Play button to hear your playlist.

Editing Playlists

You can use the Cut, Copy, Paste and Undo buttons or menu commands to change the order 
of events in a playlist, or to copy events from one playlist to another.

To copy or cut events from a playlist:

1. Select the events you wish to copy or remove. Use the technique described earlier to 
select multiple events if you wish.

2. Choose Copy or Cut from the Edit menu, or click on the Copy or Cut button.



To paste events into a playlist:

1. Cut or copy one or more events to the clipboard as described above.

2. Open a new playlist if you wish and select an event.

3. Click on the paste button or choose Paste from the Edit menu. Pasted events are always 
inserted before the first highlighted event. To place events at the end of the playlist, select 
Deselect All from the Edit menu before pasting in a new event.

Working With CD Tracks

Unlike disk drives or CD-ROM data disks, CD-ROM audio disks do not contain directory 
structures or file names. When you place a disk in your CD-ROM drive for the first time, 
Windows Jukebox can only display [Untitled] as its title, and a generic title for each track; 
Track 1, Track 2, and so on. To display the correct titles, you must enter them manually from 
the Sound Event Manager.

We suggest that you create a reference playlist for each CD in your collection, listing all of its
tracks. You only need to do this once for each CD. Then copy tracks from the reference list 
into other playlists.

To create a CD reference playlist:

1. From the file menu, select New to open a new, empty playlist.

2. Place an audio CD in your CD-ROM drive.

3. Click on the Add... button to enter the Sound Event Manager, then click the CD button.

4. Enter a title for this disk in the CD Title box. You will probably want to enter actual title of 
the CD, but you can enter any text you wish.

5. Highlight the "Track 1" line.

6. Enter the desired title in the Track box at the bottom of the Sound Event manager window.
(You can temporarily remove the CD from the drive to look at the track titles if you wish. Be 
sure to replace it before continuing.)

7. Select the Track 2 line and continue entering titles in this manner for all of the tracks. 
(Note: you cannot save this list of titles.)

8. Double-click on each of the tracks, in the order you wish, to add them to the Playlist.

9. When all the tracks have been transferred from the Sound event Manager to the Playlist, 
save the Playlist.

Now you can copy titles from the reference playlist into any other playlist and the disk and 
track titles will be displayed correctly. You don't need to put the disk in the drive to copy 
tracks from one playlist to another but you must load the correct disk when you want to hear
your playlist.

ALERT: Since only one CD can be in your CD-ROM drive at a time, all CD tracks in a given 



playlist must reside on the same CD.

Compatibility with Other CD-ROM Software

Jukebox stores track names and CD disc titles in a file called MUSICBOX.INI. A number of 
other programs also use this file, and because they do, they're all compatible. (Microsoft's 
Musicbox, Voyetra AudioStation and the Voyetra CD Player are a few examples.) This means,
however, that if you use one of these compatible programs to edit titles, track names or 
playlists, you may see the effect of some of those changes next time you run Jukebox.



Windows Digital Audio Transport

Windows Digital Audio Transport allows you to play, record and edit digital audio files with 
your sound card.

Screen Layout

Controls and Displays

Menu Bar

WinDAT's Menu bar, at the top of the screen, contains selections for File, Edit, Transforms, 
Options, Windows and Help choices.

Transport Controls
Transport controls are located at the top of the screen, directly beneath the Menu bar. 
WinDAT uses familiar Transport Controls that duplicate those found on a VCR or tape 
recorder.

Rewind (Double Backward Arrow) : Clicking and holding the Rewind button moves the 
pointer backward through the file in small increments. To rewind more rapidly, Shift -click 
and hold the Rewind button.

To return to the beginning of a file, double-click the Rewind button.

Stop(Square Button) : Clicking the Stop button halts playback or recording and 
automatically rewinds to the position at which playback or recording started. 

Play (Single Forward Arrow) : Clicking the Play button initiates playback, starting from 
the current position.. 

Record (Red Light): Clicking the Record button puts WinDAT into record ready state. 

After clicking the Record button, the Record button's red LED will blink. Click the Play button 
to begin recording.

Pause (Double Bar) : Clicking the Pause button will temporarily halt playback or recording.
Once paused, clicking again on the Pause button will resume playback or recording without 
rewinding.

Fast Forward (Double Forward Arrow) : Clicking and holding the Fast Forward button 
moves the pointer forward through the file in small increments. To advance more rapidly, 
Shift-click and hold the Fast Forward button.

To advance to the end of the file, double-click the Fast Forward button.

Range Controls



The Range Controls, located beneath the Transport buttons, let you select a precise portion 
of the file for playing, editing or transforming.

The selected portion of a file is referred to as a "range", and is defined by its Start and End 
times in seconds. The Start and End times can be specified to a precision of 1/100th of a 
second.

Mark    Range (Downward Arrow) : Lets you mark a portion of a file "on-the-fly" as you 
listen to it play back.

Play Range (Bar - Forward Arrow - Bar) : Plays the selected range.

Start/End Numericals: Display and allow you to adjust the Start and End times of the 
range in Minutes:Seconds.Hundredths of seconds. Start Numericals are shown in the box at 
the left and End numericals are displayed in the box at the right.

Numericals are small boxes that display parameters or values and give you a quick way 
adjust them. Wherever space permits, numericals are identified by a small pair of triangular 
up/down pointers at the right.

Two ways to operate a numerical:

 1. To increase the value or to move upward in a list of choices, place your mouse 
pointer anywhere in the top half of a numerical. To move down or decrease the value, place 
your mouse pointer in the lower half. Then:

Single click - to change the value by one step, or to select the previous or next item 
from a list.

Click and hold - to move up or down more quickly. Changes occur slowly at first, then 
after a second or two, the rate of change accelerates. Release the button as you approach 
the desired value, then use single clicks to make your final selection.

 2. You can also click on the numerical and drag your mouse up to increase the value 
or down to decrease it. (You will notice that your mouse pointer disappears from the screen 
during this operation.)

VU Meters: Indicate the Record and Playback level.

Drag and Drop Icon: Places a WinDAT file into an OLE client document with a simple 
mouse movement.

Graphic File Display
The Graphic File Display in the main screen area is a visual representation of the digital 
audio file currently loaded into WinDAT. The horizontal axis represents time (moving from left
to right); the vertical axis represents amplitude (loudness).

A red line, called the Play Position Marker, displays the point in the file where playback will 
begin. During playback, it moves from left to right across the Graphic File Display. The scroll 
bar at the bottom of the Graphic File Display moves the Play Position Marker.



You can select any part of the file for editing or transform operations. Whenever a range is 
selected, it is displayed in reverse.

Status Area
The Status Area at the bottom of the screen contains information about the current audio 
file:

Mono/ Stereo: Indicates whether the audio file is mono or stereo.

KHz: Displays the sample rate of the currently loaded audio file in kHz.

Bits: Displays the bit length of the current file.

Cur: Displays the position of the play position marker in Minutes:Seconds.Hundredths of 
Seconds.

File: Displays total length of the file.

Menus

File Menu
New: Creates a new, empty file based on the settings in the Setup window.

Choosing New does not erase the contents of the Clipboard.

It is not necessary to choose New before recording. When you record, WinDAT always 
replaces the currently loaded file with newly recorded material.

Open: Presents a dialog box to select the file you want to load. You can select which file 
extension (VOC or WAV) you want to look for. The Audition feature lets you    hear samples of 
files as you browse.

Save: Saves the current file to disk, overwriting the existing version.

Save As...: Presents a dialog box for naming and saving the current file to disk.

Exit: Terminates the WinDAT program.

File List (1 2 3 4): Allows single-click opening of the four the most recently-opened audio 
files.

Edit Menu
Undo: Restores the file to the state it was in before the most recent Edit or Transform 
operation.

Cut: Removes the selected range and shifts the rest of the file back to fill in the gap. The 
deleted data is placed in WinDAT's Clipboard.

Copy: Puts a copy of the selected range in the Clipboard without altering the file.



Paste: Inserts the contents of the Clipboard at the Start point and shifts any data after that 
point to the right.

Mix Paste: Mixes the contents of the Clipboard with the data in the current file, beginning 
at the Start point.

Select All: Selects the entire file as the range.

Delete: Removes the selected range; shifts remaining data left to fill the gap; does not copy
the data to the Clipboard.

Erase: Puts a copy of the selected range in the Clipboard and replaces the selected range 
with silence.

Trim: Deletes all data except the selected range. The contents of the clipboard remain 
unchanged.

Insert Silence: Inserts an interval of silence at the Start point of the selected range, 
shifting any data after that point to the right. You    can use a slider or a numerical to set the 
duration of the silence from .01 to 10 seconds.

Transforms Menu
Normalize: Increases the amplitudes in the selected range as follows: the peak value is 
scaled to the maximum possible amplitude, all the other amplitude values are scaled by the 
same factor. Normalize can improve files that have been recorded at too low a level, without 
introducing clipping distortion.

Find Peak: Scans the selected range and:

Displays a pop-up window reporting the value and location of the peak amplitude in the 
range.

Moves the Current Play Position to the peak.

Selects a new range with its Start point 1 second before the peak and its End point 1 second 
after the peak.

Find peak is useful for locating an unwanted spike so that it can be Scaled or Deleted.

Scale: Increases or decreases the loudness in the selected range by a factor that you 
specify. Scale is useful for matching the loudness of two files before performing a Paste or 
Mix Paste operation.

WAV ->> VOC or VOC ->> WAV: Converts 8-bit PCM WAV files to the Sound Blaster VOC 
format, or VOC files to 8-bit PCM WAV format.

Change Speed: Changes the speed and pitch of a digital audio file by altering the    sample 
rate.

Options Menu
Auto Audition: When enabled, lets you play each file by clicking on its file name in the 
Open and Save As dialog boxes.



Auto Rewind: When enabled, WinDAT automatically rewinds to the beginning of the file 
when it stops playing.

No Wave: When enabled, the Graphic File Display disappears and WinDAT's window shrinks 
vertically. Use No Wave to eliminate waiting for screen re-draws, to reduce the amount of 
system overhead when playing back files at high data rates, or to make room on your 
desktop for other applications.

Playback VU,    Record VU: When enabled, WinDAT's VU Meters will be active during 
playback or recording. If you experience problems playing or recording files at high data 
rates, try disabling the VU meters to reduce system overhead. The VU meters are disabled 
during recording or playback of compressed files.

Windows Menu
Setup: Displays the Setup dialog box where you can choose settings for a file prior to 
recording. For details, see "Recording New Files" in the Tutorial section below.

File Format: - Allows you to select .WAV or .VOC file format.

Data Format: - WinDAT automatically detects and lists all of the data formats/compression 
schemes supported by your sound card.

Stereo: - Toggles Stereo on and off. (Appears only for card models that support stereo.)

Sample Rate: - Allows you to select a sample rate in Hz. Refer to the your sound card's 
documentation for its supported sample rates.

Work Directory: - The default directory that WinDAT will use when opening or saving files.

Temp Directory: - The directory that WinDAT uses for temporary storage when you record, 
edit or transform digital audio data.

Clipboard: Displays information about, and allows you to audition, the contents of WinDAT's
Clipboard:

From: - The source file from which the data was Cut or Copied.

Sample Range: - The starting and ending sample numbers, referenced to the source file 
from which the data was Cut or Copied.

# Samples: - The total number of samples in the clipboard data.

Duration: - The duration of the data in the clipboard.

Sample Rate: - The sample rate of the data in the Clipboard. Note: Data pasted from the 
Clipboard will play back at the sample rate of the file it is pasted into.

Format: - The bit length and mono/stereo setting of the data in the Clipboard.

Transport buttons: - Play only the material currently in the WinDAT clipboard. Use these to
check the contents of the clipboard before you paste it into a file.



OK: - Closes the Clipboard window and returns you to the main screen.

Tune Performance: Lets you optimize WinDAT's performance or fix problems you might 
encounter during recording or playback, especially with high data rates. For more 
information, see the Troubleshooting section.

File Info: Displays a summary of information about the current file: File Format, Data 
Format, Sample Rate, Channels (mono or stereo),    Number of Samples in the file, and the 
total File Size.

Sample Digital Audio Files

WinDAT includes a selection of MusiClips™ digital audio files to use with your sound card. 
These files are in .WAV format for compatibility with Windows and many DOS applications.

Tutorial
Loading and playing    WAV files

To open and play a digital audio file:

 1. Choose Open from WinDAT's File menu and navigate to the directory where your 
digital audio files are located, and click on a filename in the Files list.

To hear the highlighted file, press the Audition button. If Auto Audition is enabled, 
you'll automatically hear each file as you select it. To stop audition playback, choose a 
different file, or click anywhere in the Directories list.

 2. To open a file, double-click on its filename, or highlight the desired file name and 
choose OK.

After the file loads, a graphic representation of the audio file will fill the graphic file 
display, and the length of the file will be displayed in the File indicator at the bottom right of 
the window.

 3. Click the PLAY button in the Transport Controls area.

The digital audio file will play, and stop when it reaches the end. The red Play Position
Marker moves from left to right as the file plays.

To halt playback momentarily, click on the Pause button. Click the Pause button again
to resume playback.

To rewind the file:

 1. Double-click the REWIND button in the Transport Controls area. WinDAT will return 
to the beginning of the file.

 2. If Auto Rewind    (in the Options Menu) is enabled, WinDAT rewinds automatically 
every time you stop playing.

Recording Files



Your system must be set up correctly before you can record. Ordinarily, the installation 
program prepares your system so you can record right away. You might want to take the 
following steps, however, to familiarize yourself with WinDAT's setup procedures or to 
confirm the settings. Once setup is completed, you only need to repeat this procedure to 
change settings.

To prepare your system for recording:

 1. Connect the audio source (microphone, CD player, tape deck, etc.) to the 
appropriate input jack on your sound card. Refer to the sound card's hardware 
documentation if you need help with this.

 2. Use your Windows mixer to select an input source and set the recording volume 
level.

 3. From the Windows menu, choose Setup.

 4. Select the desired File Format (.WAV or .VOC).

 5. If you've selected WAV as the File Format, select the desired data format from the 
Data Format combo box. Some systems support one or more types of data compression; if 
so, they'll be listed here.

 6. Choose a Sample Rate from the Sample Rate combo box.

You can choose a sample rate from the list, or type in any sample rate supported by 
your sound card. Not all cards support all sample rates. Higher sample rates give you better 
audio quality, but also create larger files.

 7. Select mono or stereo. The green indicator on the Stereo button will be lit when 
stereo is enabled. (This button is only present if your sound card supports stereo.)

 8. Check the entries in the Temp Directory and Work Directory. Make sure that they 
are valid directories and that they have enough free space to accommodate the file you plan
to record.

 9. Choose OK to return to WinDAT's main window.

If you receive the message, "Unsupported Format," you've most likely entered a sample 
rate, data format or mono/stereo selection that is not supported by your sound card. Check 
your sound card's manual to find its capabilities.

If this is your first attempt to record, we suggest that you start with an 8-bit PCM file in .WAV 
format, at 11,025 Hz.

To record and save a new file:

 1. If you're recording from a CD-ROM drive, CD Player, or tape deck, cue up the 
material as needed.

 2. Click on the Record button in the Transport Controls area. The blinking red light 
indicates that WinDAT is in Record Standby mode.

 3. Click the Play button to start recording. The red light will stop blinking and remain 
lit, indicating that WinDAT is recording.



 4. Speak into the microphone, or play the material you prepared earlier.

To temporarily halt recording without losing already recorded material, click the 
Pause button. Click the Pause button again to resume.

 5. Click on the Stop button to stop recording.

 6. Click the Play button to hear what you've just recorded.

 7. Choose Save from the File menu, type a new file name in the dialog box, and 
Choose OK.

Editing Files

With WinDAT's editing tools you can cut, copy, paste, insert, or delete data within a file or 
among several files. You can run several instances of WinDAT simultaneously to simplify 
cutting and pasting between different files.

Selecting a Range for Editing
All of WinDAT's Edit functions require that you specify the section or range of the file that 
you wish to edit. If you've ever used a word processor, this concept will probably seem 
familiar right away. When a range is selected, it appears in reverse video on the graphic file 
display.

There are several ways to select a range. You can click, hold and drag your mouse across 
part of the graphic display, or select a passage on-the-fly as you listen. 

The Start and End numericals in the Range Controls area show the exact beginning and end 
point of the selected range, and allow you to adjust its boundaries to a precision of 1/100th 
of a second.

The Play Range button allows you to listen to the selected range, so you can verify your 
selection.

To select a range with your mouse:

 1. Click on the desired Start point in the graphic file display.

 2. Drag to the right. At the desired End point, release.

To select the entire file, double-click anywhere in the Graphic File Display, or choose 
Select All from the Edit menu.

To select a range as you listen:

 1. Play the file, listening for the position you've chosen as the start point and when 
you hear the section you want, click on the Mark Range button with your mouse. Hold the 
mouse button down as the passage plays.

 2. Release the button at the end of the desired section.



 3. Click the stop button.

 4. Click the Play Range button to play the selected range.

To make rough adjustments to the selected range:

 1. Place the mouse cursor at the desired location in the graphic file display.

 2. Hold the Shift key and click. The Start or End point    whichever is nearer    will jump
to the mouse cursor. The other point will not be affected.

To make precise adjustments to the selected range:

 1. Click anywhere on the Start or End Numerical and drag up or down to reach the 
desired Start or End time.

 2. Click on the upper or lower half of the numerical to adjust the time by 1/100th of a
second.

Using the Edit Functions
WinDAT's editing functions work like those in a word processor. You can cut, copy, paste or 
delete digital audio data as you would text. Your "cursor position" is always the Start point of
the selected range.

Data that you cut or copy is temporarily stored in the WinDAT clipboard until you replace it 
with different data or close WinDAT. When you close WinDAT, any data in the WinDAT 
clipboard is lost, even if    Windows remains open.

To remove a section of a file:

 1. Select the range of the file that you wish to remove.

 2. Choose Cut from the Edit menu. The selected range is deleted from the file and 
copied to WinDAT's clipboard. The rest of the file shifts to the left to fill the gap.

 3. Play your file to check the results.

To paste the contents of the Clipboard into a file:

 1. Use the procedure above to place some data in the Clipboard. If you don't want to 
remove the data from the source file, use the Copy command instead of Cut.

 2. If you want to Paste the clipboard contents into a different file, load that file now.

 3. Select a range, and adjust its Start to the point where you want to paste the data. 
(The end point of the selected range can be anywhere: it has no effect on paste, mix paste 
or insert silence operations)

 4. Choose Paste from the Edit menu. The contents of the Clipboard will be inserted at
the designated Start point. Any data after that point will be shifted to the right.

If you want to blend sounds, choose Mix Paste. The clipboard contents will be inserted
at the designated Start point, but will merge with data to the right. If necessary, the file will 



lengthen to accommodate the new data.

If you want to create a new file from the clipboard contents, choose New from the 
Files menu before you paste.

To insert an interval of silence in a file:

 1. Select a range, and adjust its Start point to where you want to insert the interval 
of silence.

 2. From the Edit menu, choose Insert Silence. Enter a time interval in the dialog box 
and choose OK. A silent interval of the length you specified will be inserted at the 
designated Start point. Any data after that point will be shifted to the right.

To undo the most recent edit or transform:

Choose Undo from the Edit menu.

Modifying files with the Transforms

WinDAT includes a category of functions called Transforms which allow you to modify your 
digital audio files.

Like the Edit functions, the Transforms also operate on a selected range. Some Transforms 
operate only on the entire file.

We'll use Scale as an example of how to use a Transform. The Scale Transform increases or 
decreases the loudness of the selected range by a specified factor. For example, a scaling 
factor of 2.0 would double the loudness; a scaling factor of 0.5 would halve the loudness.

The Scale function is useful for matching loudness when you're cutting and pasting between 
different files. 

To scale the loudness of a selected range:

 1. Select the range you want to scale, or choose Select All from the Edit Menu to 
select the entire file.

 2. Choose Scale from the Transforms menu.
              
                          3. In the scale dialog box, place your mouse pointer on the slider and drag it up 
or down to the desired scaling factor.

 4. Choose OK.

The rest of WinDAT's Transforms work in the same manner. You'll find a complete description 
of each Transform function and menu item in the Menu section.

Using WinDAT with Other Programs
Drag-and-Drop File Loading
WinDAT works with file management utilities that support drag-and-drop file sourcing, such 
as Windows File Manager,    Norton Desktop™ for Windows, XTree™ for Windows. If you don't 



know whether your application supports drag and drop, just try the procedure below.

To load a file into WinDAT with drag-and-drop:

 1. Run a drag-and-drop compatible application, such as Windows File Manager.

 2. Navigate to the directory where the desired file is located.

 3. Drag the file name icon into WinDAT's Graphic File Display. WinDAT will load the 
file.

WinDAT's OLE Support
WinDAT supports a feature of Windows 3.1 called Object Linking and Embedding (OLE). OLE 
enables you to place information from one application    into a document created by another 
application, even if the two applications use very different types of data. If you are not 
familiar with OLE, consult your Windows documentation before you continue.

WinDAT is an OLE Server; you can embed or link WinDAT sound objects into documents 
created with any OLE Client.

You can use WinDAT to edit sound objects from within the client document.

WinDAT's unique drag-and-drop OLE icon offers a quick, intuitive way to embed sound 
objects into OLE Clients.

When you've linked or embedded a sound object, a copy of the WinDAT    icon serves as a 
place holder at the appropriate point in the OLE client.

To embed a sound file in a document:

 1. Load or record the desired sound file into WinDAT.

 2. Drag WinDAT's drag-and-drop OLE icon to the desired point in the destination 
document and release the mouse button.

To embed a selected part of a sound file:

 1. Load or record a sound file in WinDAT.

 2. Highlight the desired range in the Graphic File Display

 3. From WinDAT's Edit menu, choose Copy.

 4. Click on the desired insertion point in the destination document.

 5. From the client document's Edit menu, choose Paste.

To link a sound object:

 1. Load or record the desired sound file into WinDAT.

 2. Make sure the file is saved.



 3. Select any part of the file. (This procedure creates a link to the entire file, so it 
doesn't matter what you select, but you must select something.)

 4. Select Copy from WinDAT's Edit menu.

 5. Click on the desired insertion point in the destination document.

 6. From the client document's Edit menu, Choose Paste Link.

NOTE: If you give the client document to anyone, you must also include a copy of the linked 
sound file.

To play a WinDAT sound object:

 1. In the client document, double-click on the WinDAT icon representing the sound 
object you wish to play.

Another method is to select the WinDAT icon and choose Sound [VOY] >> Object, 
Play from the document's Edit menu.

Some OLE clients implement OLE functions differently. Check the client application's 
documentation for details.

To edit a WinDAT sound object:

 1. In the client document, click on the WinDAT icon representing the sound object 
you wish to edit.

 2. From the client document's Edit menu, choose Sound [VOY] Object >> Edit. 
WinDAT will start, with the sound object already loaded.

 3. Edit the sound object in WinDAT as desired.

 4. Update the sound object in the client document:

If you're editing an embedded sound object, choose Update [application name] from 
WinDAT's File menu.

If you're editing a linked sound object, choose Save from WinDAT's File menu. This 
will overwrite the original sound file.

Fixing Digital Audio Problems
If you're having problems with WinDAT, follow the general procedures below. Fortunately, the
situations that most often cause problems are also the easiest to fix so this troubleshooting 
guide starts with the simplest problems and fixes.

Throughout the troubleshooting process, don't forget another valuable resource: the 
hardware manuals that came with your sound card or other peripherals.

Problem: Nothing works  all I get is silence:
Check your Mixer Setting:



In particular, check the Master volume setting, and make sure all the appropriate mixer 
settings are high enough. For more information on mixers, see the hardware manual that 
came with your sound card.

Check your Sound Card Connections:

Your sound card must be connected to a working output device such as headphones, 
speakers or an amplifier with speakers. If your speakers are connected directly into the 
sound card, (i.e., without an amplifier), you should be using the self-powered type speakers. 
The sound card's amp isn't designed to power external speakers.

Check your Software Installation

If you tried to install the software before you've successfully installed and tested the sound 
card and its drivers, you need to backtrack. Carefully read your sound card's installation 
instructions and try once more. Install the sound card first, then the sound software.

Check Cable Connections:

Be sure you've connected the cables correctly. Have you inadvertently plugged your 
headphones to the microphone input, or made a similar mistake? Double check the 
soundcard's hardware installation instructions to make sure you've used the right 
connectors.

Check your Sound Card Installation:

Be sure all of the cards in your computer are installed firmly and with good electrical 
contact. If you need to force or twist a card's bracket to secure the screw, the card is 
probably not installed correctly in its slot. It often takes a firm push to seat the card properly.
Dirty contacts on either the card or the slot can interfere with electrical connections. If this 
seems to be a problem, try a different slot or polish up the contacts on the sound card with a
clean pencil eraser.

Check your Computer's Hardware Settings:

(Interrupts) Check IRQ, I/O address, DMA settings for errors or conflicts. If you are using 
several devices like scanners, MIDI interfaces, tape backups and so on, there may be two 
devices competing for the same IRQ channel. If so, you'll need to find and resolve the 
conflict, usually by changing a setting on one of the devices. MSD.EXE, a utility that comes 
with DOS version 6.0 and higher, can help you locate such conflicts. Some cards use 
hardware (DIP switches, jumpers) to change settings and others use software. Some devices 
won't allow you to change the interrupt setting at all and the change must be made on the 
other implicated card. 

Problem:    I'm getting sound, but there's interference along with it:
Check your Sound Card Settings:

A hum, hissing or other constant undertone of    noise usually indicates a hardware 
malfunction. Try increasing the soundcard's output level and lowering the amplifier's volume.
If that doesn't help, try it the other way around.

Check for Electrical Interference:



Move the computer and/or cables away from potential sources of electrical noise such as 
household power cords, fluorescent lamps, or any electrical device controlled by a dimmer.

Check the Placement of Cards inside your Computer

Sometimes it helps to re-arrange cards inside the computer. Try moving the sound card to a 
slot as far away as possible from your video display card and the computer's power supply.

Problem: I get good sound at first, then it turns bad:
Check your Computer's Capabilities:

Many problems with digital audio stem from the high rate at which data must be pushed 
through the computer system. A 44 kHz file at a resolution of 16 bits forces your system to 
move almost 100K of audio data between your sound hardware and hard disk every second. 
This can push some systems, especially slower computers, hard drives, or CD-ROMs to their 
limit. 

The steps below may help you solve these problems and they can help to prevent problems 
as well.

Reduce System Overhead

Close any Windows applications that you're not using.

Run Windows in Standard mode. Start Windows with this command:

        WIN /S

Reduce WinDAT's screen display overhead: From the Options menu, disable Record VU or 
Playback VU, and select No Wave.

Don't use hard disk compression utilities

Disk Compression utilities such as Stacker™, DoubleSpace™ and others add steps to the 
process of reading and writing data, which can bog down performance. Don't use 
compressed drives to record or play digital audio files, and don't assign them as the Work 
directory or Temp directory in the Setup window.

Don't confuse the file compression schemes designed for digital audio (e.g., ALaw, µLaw) 
with hard disk utilities that compress files of all types (e.g., Stacker™,    Disk Doubler™, 
DoubleSpace™). These hard disk utilities aren't very effective with digital audio; in some 
cases they can increase file size or cause other problems.

De-fragment your hard disk

As you delete files from a disk, you make areas available for new data. When you save a 
new file, DOS breaks the data up and fits the pieces into these scattered openings. 
Sometimes the read/write head of a hard disk simply can't jump around among these 
openings fast enough, and digital audio performance suffers. This condition, called disk 
fragmentation, can be especially severe in large disk partitions supported by recent versions
of DOS. Disk optimizing utilities such as DEFRAG (included with version 6 of DOS), and 
others can sort out and re-assemble files. Optimize your hard disk regularly.



Make a disk partition just for digital audio

You can create a separate hard disk partition just for digital audio. Your DOS manual explains
how to use the FDISK utility to do this. After you've created the new partition (20MB is a 
good size), use WinDAT's Setup window to assign it as the Temp Directory.

Adjust the Tune Performance options

The Tune Performance window displays and lets you adjust three parameters that affect 
WinDAT's performance.

Use this window only after you've tried the measures described above.

Note settings before you change them, and keep track of the changes you make.

Look for the smallest adjustment that solves the problem.

Play Buffer: When you play digital audio, WinDAT sets aside a buffer, a portion of your 
system's RAM, to momentarily hold data and prevent bottlenecks. The capacity of the buffer 
is expressed in seconds; the default is 4 seconds. Try increasing its size in steps of about 2 
seconds.

Record Buffer: Works in the same manner as the Play buffer. Default is 8 seconds. If you 
have trouble recording, try increasing the size.

The message, "Unable to allocate enough memory" indicates that you've requested more 
memory than your computer can provide. Decrease the size.

Pre-Write: To avoid file fragmentation, WinDAT creates or pre-writes an unfragmented file 
on the hard drive prior to recording. The Pre-Write setting establishes the size of this file. The
default is 128K. If increasing the Record buffer hasn't solved your data rate problem, set a 
Pre-Write value slightly larger than size of the file you'll be recording (in Kilobytes).

Use a less demanding data format

If none the measures above works, you are probably exceeding the capacity of some 
hardware component in your system. Until you can upgrade, you'll have to decrease the 
demands you place on your system:

Try decreasing the sample rate.

If you're attempting to record 16-bit audio, try switching to 8-bit.

If you're recording in stereo, try switching to mono.

Don't use compressed digital audio file formats.

The demands of recording and editing digital audio can tax many computer components, 
particularly older, slower ones.

Check your Computer's Hardware Settings:

(Interrupts) If sound suddenly stops or "stutters," and/or locks up your computer, you 
probably have more than one device trying to use the same IRQ, I/O address or DMA 



channel. You need to track down these settings for the peripherals in your system and 
change them to eliminate the conflict.

Problem: I can't play an embedded file
Check OLE:

OLE enabled applications use a feature of Windows called Object Linking and Embedding to 
place digital audio files into files created in other applications, such as word processors or 
presentation programs. OLE technology is still evolving and different versions have been 
included with different Windows applications    and Windows itself! If you are experiencing 
problems getting OLE sound objects to play, be sure to check your Windows manuals as well
as the program's documentation to resolve the problem.

Error Messages
Message: "Audio driver not found - Audio functions disabled."

Message: WinDAT causes a Windows "General Protection Fault".

Solution: Try to play the file with the Media Player. (You should find it in the Accessories 
Program Group.) If the Media Player can't play the file, the problem is most likely the 
installation or configuration of the .WAV driver.

From the Control Panel's Drivers applet, choose Setup to verify that the sound card's .WAV 
driver is configured to use the correct IRQ, I/O address, DMA channel settings. Your hardware
manual will tell you what the correct settings are. Correct the settings if necessary, re-start 
Windows and run WinDAT again.

If the problem persists, re-run the sound card's installation routine. Be sure that you enter 
the correct hardware settings (IRQ, I/O address, DMA).

Message: "Unsupported Audio File Format", "Invalid Bit Length", or " Invalid Sample Rate."

Solutions: WinDAT lets you open and edit any standard WAV or VOC file, but if you try to 
play back a file whose format (sample rate, bit length, mono/stereo setting, compression 
type, etc.) is not supported by your sound card, WinDAT will display one of the above error 
messages. This is more likely with files created on a different system. You may need to re-
create or convert the file. Check the hardware documentation to determine the digital audio 
capabilities of each system, and use a format supported by both.

 




